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Introduction

This document describes operation when performing cutting with the MDX-650/500 using RML-1.
To perform cutting using RML-1, the command selection must be set to RML-1 when the MDX-650/500 is switched on. For information
on how to select commands, see "User's Manual 1 -- Setup and Maintenance.”

If you're using the MDX-650 with the optional rotary axis unit (ZCL-650), also see the “ZCL-650 User’s Manua” included with the
rotary axis unit.

Setting the Command Set to RML-1

This chooses the instruction set immediately after switching on the power. When an instruction set has been chosen, it cannot be changed
until the power is reset.

1 Switch on the power.

After the opening message, the screen for selecting the 1 e
instruction set appears. E
O
2 Turn the dial to move the arrow to [RML-1], then press m— : Vi A
the [ENTER] key. Ht "ENTER'" >RML-1 o

Sel ect MODE NC- CODE

1

Choosing the Spindle Type

This sets the type of the installed spindle to MDX-650/500.

If ahigh-torque spindleisinstalled, choose [HIGH TORQUE]. If a high-speed spindle isinstalled, choose [HIGH SPEED]. An incorrect
selection may result in insufficient power to the motor and make normal cutting impossible, or conversely may apply power beyond the
rated capacity to the motor and cause an error to be displayed during cutting.

1 If the display shows coordinates, press the [ENTER] key *X 0 Y 0
to display the main menu. 7 0 5000 RPM E o R

!

>1 SPEED SETTI NG
2 SPINDLE RPM




>10 OTHERS
11 To Coordinate

1

2 Turn the dial to move the arrow to [OTHERS], then press V4 A
the [ENTER] key. o

Turn the dia to move the arrow to [SPINDLE UNIT], Vi \
3 then pressthe [ENTER] key. (@) 10>§ SE'ZEIE:QE UNIT
ENTER
(@)
Turn the dia to move the arrow to [HIGH TORQUE] or V4 A -
4 [HIGH SPEED], then press the [ENTER] key. (@) 10-2 SPLHPLGE -&-1%5

The selected mode is enclosed in angle brackets.

1 or
[HIGH SPEED]

* To go back to the main menu, pressthe [EXIT] key
severa times.
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Part 1 Installing the Software

—

The Roland Software Package CD-ROM contains many different kinds of software.

You can view the software that can be used with MDX-650/500 by displaying the setup menu on the CD-ROM and choosing the model
of MDX-650 or MDX-500 .

See below for overviews and brief description of usage for the software displayed on the setup menu.

1-1 Software That Can Be Used with the MDX-650/500

Software Overview

Windows driver Thisis necessary when sending datato M DX-650/500 from a Windows-based program.
If you' re using Windows, be sure to install this driver.

MODELA programs The Windows versions of MODELA Player, MODELA 3D DESIGN, and MODELA 3D
TEXT cannot be set up separately.

MODELA Player This sets the required parameters for cutting solid objects and sends the cutting data to
MDX-650/500.
This can import not only solid objects created with three-dimensional programs from
Roland DG Corp., but also solid objects created using other commercially available three-
dimensional programs (via DXF or STL).

MODELA 3D DESIGN This lets you choose a basic shape such as a cylinder or sphere, and modify it to create a
three-dimensional object.
You can intuitively create solid objects with smooth curves.
You can use MDX-650/500 to cut solid objects and save datain three-dimensional DXF
files.

MODELA 3D TEXT This adds thickness to text to create three-dimensional characters.
It's also possible to edit text to make it bold, italic, or the like. You can put a box around
text with just asingle click — a handy feature when making namepl ates.
You can use MDX-650/500 to cut three-dimensional text and save data in three-dimen-
sional DXFfiles.

Virtual MODELA This simulates tool movement before performing cutting with M DX-650/500.
You can use it to check the finished shape as well as things like whether the cutting depth
is suitable and how much time cutting will take. This can reduce loss for cutting materials
and time.

Dr.Engrave Thisis used to design plates and send the engraving data to M DX-650/500.
You can make large numbers of plates with the same design with high efficiency. You can
use the TrueType fonts registered in Windows as the font style for text. You can even
make stroke fonts from TrueType fonts.
Because you can the outline of an image and convert it to line segments, it's also possible
to include logos for companies or organizations in the plates you make.

3D Engrave This adds thickness to aflat (two-dimensional) graphic to create arelief (raised engrav-
ing).
You can also add thickness to images such asillustrations.

al



Part 1 Installing the Software

1-2 Installing the Software

This section describes installation and setup for the MDX-500. If you' re using the MDX-650, then wherever “MDX-500" appearsin the
text, read “MDX-650" instead.

System Requirements

The system configuration for the programs that you can use with the MDX-650/500 (MODELA Applications, 3D Engrave, Virtua
MODELA, and Dr. Engrave) is asfollows.

- Microsoft® Windows® 95, Windows 98, Windows Me, Windows NT® 4.0, or Windows 2000 operating system
- The minimum required CPU for the operating system (Pentium® or higher recommended)

- The minimum amount of required RAM for the operating system (32 Mbytes or more recommended)

- 32 Mbytes or more of free hard disk amount is required to install all programs.

*For information about the system requirements for individual programs, refer to the Readmefile.

* |If you are installing under Windows NT 4.0 or Windows 2000, you need full access permissions for the printer settings.
Log on to Windows as a member of the “ Administrators” or “Power Users’ group.
For more information about groups, refer to the documentation for Windows.

Setup

1 Switch on the computer and start Windows.

2 Place the CD from the Roland Software Package in the
CD-ROM drive.
The Setup menu appears automatically.

3 When the screen shown below appears, click the in
Click here], then choose [MDX-500].

e B e s ca B8
To view the description of a program, click thelf_] button.
To view the manual, click the ) button. Pt
(There are manualsin PDF format for the programs that
the ) button references. Acrobat Reader is required to

view PDFfiles.)

If there are programs you don't want to install, then clear
their check boxes before you click [Install].

Go Lo Rmland D0 Fidrmsep-acge




Part 1 Installing the Software

4 The Setup program starts. Follow the messagesto carry i

out setup and finish setting up the program.
S f,ﬁ“"""‘ Thor g =l

il pEg poaewriel iy e @ Urviee mrpe
thnn ey e Sesbas piogain.

Thek Tl 0 i Ay ol [ b

WAFPRT The g b Eebete Ui gl sl
.

wm-u L e ] E
R nsianis 99 vam s st b bt b

o [T e |

* When the setup for one program finishes, the setup Inatsll ]
for the next program starts. _
In the interval until the next setup starts, adialog box .

showing the progress of processing is displayed. IE'

5 If the following screen appears while installing the driver, S M- 508 Driver Inakall =
click the drop-down arrow and choose the port for the
cable connected to the computer.

When using an RS-232C (serial) cable B =l |L|
[COM1:] or [COM2] CARCEL
When using a printer (parallel) cable
[LPTL1] or [LPT2]

Pt

6 The driver settings appear. Sathnge M- SO]
When you make the settings for the communication
parameters of MDX-500, make the parameters match the Pz LT
values displayed here. _
Click [Clos] to finish installing the driver. The driver e
settings appear. B pe cocorad 35000
[uses bt 8
Pty Hora
Skl 1
Fiopee ciaelimk Hadhams
rnsiladicn Conglsted
=]

7 When al installation finishes, the screen at right appears. Vil sl ]
Click [Closg].

8 After returning to the menu screen for installation, click Q
x|

ftware Package

i, ST A, Chnid-2, Cab-7 |

9 Remove the CD-ROM from the CD-ROM drive.
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Application Settings

When you finish installing the applications, continue by making the following settings. Be sure to make the settings before use.

=& MODELA Player

1 Click [Start].
Point to [MODELA App Group] and click [mdx3p].

2 From the [Options] menu, click [Machines...].
The [Model Selection] dialog box appears.

3 Click [MDX-500 (RML-1)], then click [OK].

4 From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

= Progesns
_'i [ ocumants
[igh Setings
d) Erd
A Help
3 Bun
BF Shul Down .
] e

F

= Aroessoies

_j HODE LA fipe G img
B H5005 Prompt

2] ‘windows Explorer

- Uinditled - WODELA Playen
Fi= Eci “iew [Opsor Help

Lepar

Abshzci ]

Comipamest Paramsier. .
Path Direchion...
biechirees

Hachenex xelmcfizn

RN AT
e L
FRIC=3T AN -2

PRG-I (AN
PRIG-21 00 LANM-ZF
PRIC- 2200 AN M-

Bpac hcalora
s el s

Fasd Fata

Eprada AFA rangs

.
¥ 8010 rn
L 30
7 1D e
W O - B e
L D5 - B e i
30 - 1300 pn

_[] CHHGEL

o Urtitled - MODELA Plager
Fie Eci view [Opion Helo

Hpen

Frird Sl

Ol
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5 Click the drop-down arrow for the name and click Priré Satup ) xf
[Roland MODELA MDX-500 (RML-1)]. i

Then click [OK]. Nave  [Fomd HOCELA T SRR L) Froste: |
St Fmady
Trex  Fokssd MODELS WDGHEINAMLA)
Whae  [OW
Cparared
P Tl
Siga | s D eres e = . = Pt

I 7 Lgrehraps

mlil

Dr.Engrave
1 Click [Start]. 3 rrgwe i
Point to [Roland Dr.Engrave] and click [Dr.Engrave]. 5 E el . , |
aiih;l E | Rclard [ Exgures ¥ [ Ergures
a] End ¥ Sislip BN D1 Engeres Hetp
£ Help B hess 05 Prompt B uriral
1 fin ) "rwiown Exphned |
B Sk Doen
[zt
2 From the [File] menu, click [Print Setup...]. File |Edi Wiew Fomel Sha
The [Print Setup] dialog box appears. Hew. Ol
Dipen.. Cv0 J
Gave [ 1
S s
Jmpost .
Selmct S,
Aopare..
Frint CH4P
Frim Py
Frimd Sstug
3 Click the drop-down arrow for the name and click Frint Salup i |
[Roland MODELA MDX-500 (RML-1)]. s
Then click [OK]. T Browion |
St Feady
Troe  Roksd MODELS MOCHSOAMLA)
Whae O
Cowninei
P Tl
Sge [Uss Debsd Sow = . = Pt
I I Lgrehraps
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ﬂ 3D Engrave

1

2

4

5

Click [Start].
Point to [Roland 3D Engrave] and click [3D Engrave].

From the [Cut] menu, click [Machines...].
The[Model Selection] dialog box appears.

Click [MDX-500 (RML-1)], then click [OK].

From the [File] menu, click [Output Device Setup].
The [Print Setup] dialog box appears.

Click the drop-down arrow for the name and click
[Roland MODELA MDX-500 (RML-1)].
Then click [OK].

- Hiogars 'l

3 Documents P | o Aconisedat r-l

am P || Fiokand 30E ngrarve & A0 Ergrsw

BN D Engeaes Hep
% urital

] Erd ¥ e Sip
& Help B pe 05 Prompt
771 fiun ] "redeen Exphued

B Shut Doen
[#51an

Helisd Lux Help

Coaate Tool Palh

Cyyohonize Pasarmestar. .
Path Dpechon .
[EE

Harkanex weleciisn x|

Spacfizaiora
s el s ¥ BN n

e L
e ¥ 900 o
PRI~ A AMM-2 - e
PRSI0 (DAMM-2 :

PRIC-1 00 (AN M-

PRIC- 20 (DAM M- Fasd Futa

o O - EDD g
T 0 - B A

Sprcda AFM rnga 300 - 1200 pn

_[ ] I CAHGEL

Ei= Edit Miew |mage Shepe Hebel D Help

Heew Chl=H
Dpen. Cat=0
Gave Cole
————
Clutput Diewice Sahup,
Fiefsierca
Ejt
Prirk Salup 1%
Prrksr
Bawse  |[Rotesd MODELE WG SOAML ] Frpwin: |
Siahn sy
Tree  Aoked MOCELS WIE SONAMLA)
Y b in )|
Cidrarand
Paps Tkl
Sigr [|Uss Dt Sie = " Pigetust
A

I Lgchraps

14|

I I
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Part 1 Installing the Software

1-3 How to Use Help

If you have trouble using the program or driver, see the help screens. Help contains information such as descriptions of software opera-
tion, explanations of commands, and tips for using the software more effectively.

1 From the [Help] menu, click [Contents].

ik Help
Contents
About...
2 Clicking on text.that isgreen and upderllned (by asolid Eu:untents| e | | Pt | |
or dotted line) displays an explanation.

Contents -Help

B Overview

B Names and Functions of Screen ltems

M Operation Procedures
Step 1: Introduction
Step 2: Setthe area
Step J: Set the conditions

3 Clicking on an image area that contains an explanation Commands - [Edit] menu

displays the explanation.

Click on any item to learn more aboot it

File Wiew Object Help

Urdo Chr+
Cuit Chrl
Copy Chrl+C
Pazte Chel+yf
Delete  Del

Select Al Chri+d,

Tip:
- When the pointer moves over green underlined text, it changes to a pointing hand ( -::1:1).

- When the pointer moves over alocation where an explanation isincluded, it changes to a pointing hand (-::b).

11



Part 1 Installing the Software

When there's a [?] button on screen

Clicking [?] in the upper-right corner of the window makes the

mouse pointer change to a question mark ( [}3? ). You can then
move the pointer over any item you wish to learn more about,
then click on the item to display an explanation of it.

When there's a [Help] button on
screen

Clicking [Help] lets you view help for the window or software.

on LPT1: Properties

gl:u:uut...J

()

] | Cancel | |

12



Part 1 Installing the Software

1-4 Overview of the Usage Guide

The included Roland Software Package CD-ROM contains the following PDF file.

- Cutting Tips

This describes tips and tricks for double-sided cutting and methods for securing the workpiece in place.

Location of the Usage Guides

The usage guide is found at the following locations.
View the following file directly from the CD-ROM, or copy the following file to your hard disk and read them from there.

- Cutting Tips
[Document] - [Cuttips] - [Cuttip-e.pdf]

Installing the Acrobat Reader

Acrobat Reader isrequired to view PDF files.
If Acrobat Reader is not set up on your computer, you need to set it up.
Theincluded CD-ROM also contains Acrobat Reader.

[Acrobat] - [English] - [ar405eng.exe]
(This runs under Windows 95, Windows 98, Windows Me, Windows NT 4.0, or Windows 2000.)

13



Part 2 Basic Operation

2-1 Making Settings Using the Liquid-crystal Display

*X 0 Y 0
0 5000 RPM

| '5!

Pressing the [ENTER] key

at this time displays the menu. Y ou can move the tool or change the spindle speed by turning the

dia while coordinate values are displayed.

To move the tool, use the [JOG] key to choose an axis (either [X],
[Y], or [Z]), then turn the dial. To change the spindle speed, choose
[??00 RPM], then turn the dial.

At thistime, a[*] (asterisk) appears next to the chosen item.

»1 SPEED SETTI NG Main Menu
2 SPINDLE RPM
\ Turn the dial to move the
arrow (p) to the item whose
setting you want to make.
»8 SERI AL PARAMVETER > 8pl STOP BIT
9 COVWPENSATE 2 DATABIT
w / \ Turn the dial to move the
O O arrow (p) totheitemwhose ~ The value (or selection choice)
Pressthe setting you want to make. enclosed in angled brackets
[ENTER] key. (< >) indicates the current setting.

<
Pressthe [EXIT] key to
o return to the previous screen. A \ Turn the dia to
1 change the setting.
: Pressthe
; [ENTER] key.
|
1
|
|
1
|

8p3 PARITY BIT 8-3 PARITY BIT
4 BAUD RATE

8-3 PARITY BIT

e Pressthe
Pressthe [EXIT] key to [ENTER] key.
© return to the previous screen.

8-3 PARITY BIT
<EVEN>

’_l

Angle brackets (< >) are displayed.
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2-2 Setting the Connection Parameters

Connection with aparallel cableiscalled a"parallel connection,” and connection with a serial cableis called a"serial connection.” Make
the appropriate settings on both the computer and the MDX-650/500 to configure the equipment for the type of connection that has been
made. Normally, the setting on the computer should be made to match the setting on the MDX-650/500. The steps below describe how
to set connection parameters on the MDX-650/500. To make the settings on the compulter, refer to the manual for the computer or the
software in use.

1 Pressthe [EXIT] key to display the main menu.

2 Turn the dial to move the arrow to [CONNECTION], >7 CONNECTI ON
then pressthe [ENTER] key. 8 SERI AL PARAMETER
3 Turn the dial to choose [AUTO], then pressthe [ENTER] 7 CONNECTI ON
key. <AUTO>
4 Press the [EXIT] key once to return to the screen at right. >7 CONNECTI ON
8 SERI AL PARANMVETER

5 Turn the dial to move the arrow to [SERIAL PARAM- >8 SERI AL PARAMETER
ETER], then pressthe [ENTER] key. 9 COVPENSATE
6 Turn the dial to move the arrow to the item you want, 8>1 STOP BI T For Ser!al
then pressthe [ENTER] key. 2 DATABIT — connection
only
7 Turn the dial to choose avalue (or selection), then press 8-1 STOPBIT
the [ENTER] key. <1>

15



Part 2 Basic Operations

2-3 Cutting Condition Setting

Before you begin the actual cutting process, the cutting conditions such as the revolution speed of the spindle motor and the feeding
speed of each axis must be designated according to the quality of the workpiece and the type of tool used. There are several deciding
factors to be taken into account when designating the cutting conditions.

The quality of the workpiece  The type of tool used The diameter of the tool used
The cutting method The cutting shape

Designate the cutting conditions in consideration of the above factors by performing the following three M DX-650/500 setting opera-
tions.

1. The spindle motor revolution speed (tool revolution speed)
2. The feeding speed (tool moving speed)
3. The cutting-in amount (depth of one cutting operation)

Note : You can set the cutting conditions using either the program or the MDX-650/500.
If you change the cutting conditions while cutting is in progress, the settings made last take priority.
(As an example, assume you pause the MDX-650/500 while cutting isin progress, then change the feed rate and spindle-
rotating speed. After you make the changes using this method, if commands for the feed rate and spindle-rotating speed
are then sent from the computer, they conditions change to those specified by the commands.)

In this manual, these three conditions are called the cutting conditions. The characteristics and points to consider for each of these
conditions are as follows.

Item Characteristics/Points to Consider
Spindle motor revolution The bigger this number, the faster the cutting speed. However, if this number istoo large, the
speed work surface may melt or burn due to excessive friction. Conversely, if this number is made

smaller, the time taken for cutting becomes too longer. Generally speaking, the entire cutting
speed is determined by the cutting edge speed, so the smaller the tool diameter, the higher the
spindle revolution speed required. (When performing engraving without rotating the cutting
tool, set [SPINDLE CONTROL] to [OFF])

Revolution speed
When [SPINDLE UNIT] isset to [HIGH SPEED]  : 5000 to 20000 rpm
When [SPINDLE UNIT] isset to [HIGH TORQUE] : 3000 to 12000 rpm

Feeding speed When the feeding speed is high, processing becomes rough and flash marks tend to remain on
the cut surface. On the other hand, when the feeding speed is slow, processing takes more
time. Be careful because a dower feeding speed does not always result in improved finishing.

Cutting-in amount When the cutting-in amount is deeper, the cutting speed increases, but the cutting-in amount is
limited by the quality of the workpiece. In cases where the required depth can not be cut at
once, repeat cutting several times to depth that does not breach the limit.

16



Part 2 Basic Operations

Setting the Cutting Conditions

This section describes how to set the cutting conditions using the display on the MDX-650/500.

* If the cutting conditions can be set with your current software, this is a faster and more efficient method than manual
setting. It makes no difference when you come to construct a program.

Speed

1 Pressthe [EXIT] key to display the main menu.

2 Turn the dial to move the arrow to [SPEED SETTING], >1 SPEED SETTI NG
then pressthe [ENTER] key. 2 SPI NDLE RPM
3 Turn the dial to move the arrow to the item you want, 1>1 XY CUT SPEED

then press the [ENTER] key. 2 Z DOMN SPEED

* Set the feed speed during cutting with [XY CUT
SPEED] and [Z DOWN SPEED], and set the
movement speed when the tool is raised with [XY
MOVE SPEED] and [Z UP SPEED].

4 Turn the dial to change the value, then pressthe [ENTER] 1-1 XY CUT SPEED
key. < 2 mis>

17



Part 2 Basic Operations

Spindle Motor Revolution Speed

Making the Setting Using the Display Menu

1 Press the [EXIT] key to display the main menu.

2 Turn the dia to move the arrow to [SPINDLE RPM], >2 SP| NDLE RPM
then pressthe [ENTER] key. 3 MECHA MOVI NG

RPM : Revolutions Per Minute

3 Turn the dia to change the value, then pressthe [ENTER] 2 SPI NDLE RPM
key. < 5000 RPM>

* The set speed is stored in memory even after you
switch off the power, and remains in effect until you
make anew setting.

Making the Setting When Coordinate Values Are Displayed

1 Press the [EXIT] key to display the coordinate-view * X 0 Y 0
screen. z 0 5000 RPM
2 Press the [JOG] key to move the [*] to [?200 RPM]. X 0 Y 0
z 0 * 5000 RPM
3 Turn the dia to change the speed. Vi A X 0 Y 0
) ) O z 0 * 5000 RPM
* When you switch off the power, the set speed islost f
and revertsto the setting for [SPINDLE RPM].

RPM : Revolutions Per Minute

Cutting-in Amount
The cutting-in amount is set by setting Z1. For more information on the Z1 setting, see"2-5 Setting the Z1 and Z2 Position."

18



Part 2 Basic Operations

Cutting Condition Setting Examples

The chart below contains reference examples of the appropriate cutting conditions for several types of workpiece material. In the case
that the conditions are input using software or when constructing your own programs, set the cutting conditions with reference to the
chart. However, because conditions differ depending on tool sharpness and workpiece hardness, cutting performance may not always be
optimal when adhering to the conditions specified below. In such acase, delicate adjustment should be performed at the time of actual
cutting.

Workpiece Tool Spindle revolution | Cutting-in amount | XY axis feeding | Z axis feeding
speed [RPM] [mm] [mm/sec.] [mm/sec.]
Modeling wax (option) ZUS-600 8000 2 18 18
ZEC-H4032 10000 05 30 10
ZHS-H4400 10000 0.8 30 5
Chemical wood ZUS-600 8000 2 20 20
ZEC-H4032 10000 04 30 10
ZHS-H4400 10000 0.5 30 5
Acrylicresin ZUS-600 8000 0.37 16 16
ZEC-H4032 10000 0.2 15 5
ZHS-H4400 10000 0.2 15 5
ABSplastic ZUS-600 8000 0.37 24 24
Aluminum ZUS-600 8000 0.2 14 3
ZEC-H4032 12000 0.05 5 1
ZHS-H4400 Without rotation | 0.1 10 1
ZDC-D2000 Without rotation | 0.1 10 1
Brass ZUS-600 8000 0.2 14 3
ZEC-H4032 12000 0.05 5 1
ZHS-H4400 Without rotation | 0.1 10 1
ZDC-D2000 Without rotation | 0.1 10 1
Sanmodur SS (option) ZUS-600 12000 3 40 30
ZUS-300 12000 2 40 30
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2-4  Setting the Origin Points (XY Origin Point and Z0)

Make the settings for the XY origin (the origin point for the X and Y axes) and Z0 (the Z-axis origin point).

About the XY Origin Point

You can choose from among three types according to the target and usage.

These are broadly divided into points are set where you want (USER) and points that are set as mechanical fixed points (LIMIT and
CENTER). For the latter, you can also choose either the front left or the center.

This section describes the selections. For information about how to make the selections, see "Choosing the XY Origin" in the following
section.

USER Table

This sets the origin point where you want. Maximum cutting range
Choose this when setting the origin point to match the position

where the workpiece is loaded. The setting is normally made at the

front-left corner of the workpiece. - b ,
E Workpiece :
LAY E
: X |
: 1 - .
XY Origin PointqUserp *
L
LIMIT Table
Thisisamechanical fixed point on the MDX-650/500, and is set Maximum cutting range
at the front-left corner of the maximum cutting range.
— S :
Y E
XY Origin Paint X :
([LIMIT]) | @ - - - - oo oo oo
CENTER Table
Thisisamechanical fixed point on the MDX-650/500, and is set Maximum cutting range
at the center of the maximum cutting range.
However, you can offset the centerpoint in order to use a center
vise. For more information, see "Offsetting the Centerpoint.” e L ..........................
Y :
X :

. XY Origin Point
| ([CENTER]) 1

........................................
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Setting the XY Origin Point
Choosing the XY Origin Point

1

Press the [EXIT] key to display the main menu.

Turn the dial to move the arrow to [ORIGIN CHANGE],
then pressthe [ENTER] key.

Turn the dial to move the arrow to the item you want,
then pressthe [ENTER] key.

If you chose [USER], then continue with the procedure in
"Setting the Origin Where You Want."

To choose [CENTER] and offset the centerpoint aligned
with the center of the center vise, see "Offsetting the
Center Location."

Setting the Origin Where You Want

If you chose [USER] with [ORIGIN CHANGE], then set the origin point where you want on the loaded workpiece.
The following section describes how to set the origin point. This section assumes that the XY origin point is set at the front-left corner of
the workpiece.

1

3

Pressthe [EXIT] key to display the coordinate-view
screen.

Press the arrow keys and the TOOL UP/DOWN keysto
move the cutting tool to a position close to the front left
corner of the workpiece.

Press the [JOG] key to move the [*] on the screen to [X]
or[Y].

4 ORIG N CHANGE
<USER>

*X 0 Y 0
YA 0 5000 RPM
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Part 2 Basic Operations

A4

Turn the dial to move the tool alittle at atime.

Repeat steps 3 and 4 to aign the center of the tool with
the front-left corner of the workpiece.

Pressthe [XY/A] key (If you're using MDX-500, press
[XY] key) to display the screen at right.

Pressthe [ENTER] key.
The screen flashes once, then returns to the coordinate
view.

Set User Origin
Ht "ENTER' key
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Offsetting the Center Location
When the [ORIGIN CHANGE] selection is[CENTER], the origin point is set at the center of the workpiece mounted in the center vise.

1

38

Turn the dial to move the arrow to [MECHA MOVING],
then press the [ENTER] key.

Turn the dial to move the arrow to [Go CENTER Pos]],
then press the [ENTER] key.
Move the tool to the center of the cutting area.

While no material is attached, tighten the center vise
completely.

Press the [EXIT] key to display the coordinate-view
screen.

Use the arrow keys and the TOOL UP/DOWN keys to
move the tool to a position near the upper surface of the
center vise.

* Here, if thetip of thetool is exactly at the center of
the center vise, you don't need to make the following
settings. The center of the cutting area matches the
center position of the center vise.

Usethe dial to align thetip of the tool with the center of
the center vise.

Pressthe [XY/A] key (If you're using MDX-500, press
[XY] key) to display the screen at right.

Pressthe [ENTER] key.
The screen flashes once, then returns to the coordinate
view.

* Thefinely adjusted center position is storesin memory even

after you switch off the power.

>3 MECHA MOVI NG
4 ORIG N CHANGE

3 >8 Go CENTER Pos

9 G LIMT Pos

*X 0 Y 0
YA 0 5000 RPM

Set Center Position
Ht "ENTER' key

*X 0 Y 0
z 0 5000 RPM
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Setting the Z0 Position

The Z0 position is the point that becomes the origin point in the Z directions. Usually, this point is set at the surface of the fixed
workpiece. (The following explains the method for setting the workpiece surface Z0 position.)

1 Press the [EXIT] key to display the coordinate-view * X 0 Y 0
screen. z 0 5000 RPM

2 Press the arrow keys and the tool up/down keys to move
the cutting tool close to the surface of the workpiece.

3 Turn the dial to aign thetip of the cutting tool with
surface of the workpiece.

»
4 Pressthe [Z] key.
5 Turn the dia to move the arrow to [Set Z0 Pos. HERE], >1 Set Z0 Pos. HERE
then press the [ENTER] key. 2 Set 71 Pos. HERE
The screen flashes once, then returns to the coordinate
view.
* The set valueis stored in memory even after you switch off
the power.
Ne=
|§ The following method can be used to set the Z0 position even more precisely. This method is suitable for cases
where the position is marked with an oil pen and later cut off.
Set Z0 as the position where the ink was cut off.
First, make amark on the work
surface with agenerally
available oil pen, etc.

p Press the [SPINDLE] key to make the
spindlerotate. Place thetool in the
marked position, then lower the tool until
theink is cut off. The ink mark on the

e work surface has a certain thickness, so
£ only theink is removed.
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Setting Z0 with the Z0 Position Sensor (Included with the

Unit)

The Z0 sensor included with the unit is used to set the Z0 point on
the surface of the workpiece. The Z0 sensor is placed on the
location which is to serve as the Z0 point, and the Z0 point is set.

1 Install the Z0 position sensor.

NOTICE Do not connect the Z0 sensor to the EXT2
connector. Doing so may damage the
sensor.

2 Place the Z0 position sensor on top of the workpiece.

3 Use the arrow keys and the tool up/down keys to move to
aposition 2 to 3 mm (0.079 in. to 0.118 in.) above surface
of the Z0 sensor.

4 Pressthe [EXIT] key to display the main menu.

Turn the dial to move the arrow to [OTHERS], then press
5 the [ENTER] key.

Z0

Z0 Position Sensor

7

2 Z0 pOSI'[IOﬂ sensor jack

Z0 position sensor g\/

7

>10 OTHERS
11 SELF MODE
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6 Turn the dial to move the arrow to [SENSOR MODE],
then press the [ENTER] key.

If the Z0 sensor is not installed, the display showsthe
screen at right for several seconds, then returns to the

previous screen.

Install the Z0 sensor, make sure the arrow is at [SENSOR
MODE], then press the [ENTER] key.

7 Use the tool up/down keys and the dial to move the
cutting tool until itstip comes into contact with the Z0

position sensor.

Press the TOOL DOWN key or turn the dial to display the

screen at right.

When the tool comes into contact with the Z0 sensor,
movement stops and the screen at right appears.

Thetool rises and the display returns to the previous

screen.

8 Remove the Z0 position sensor.

* The set valueis stored in memory even after you switch off

the power.

10>1 SENSOR MODE
2 SPINDLE UNI'T

10-1 SENSOR MODE
Z0 SENSCR NOTHI NG

\

10>1 SENSOR MODE
2 SPINDLE UNIT

10-1 SENSOR MODE
Pl ease Cursor Mve

o
*X 0 Y 0
z 0 [SENSOR]

10>1 SENSOR MODE
SET Z ORIG NI

Q_
|§ The Z0 sensor removed from above the workpiece must be placed outside the cutting range. Otherwise the cable may
become caught during operation of the XY table, damaging the sensor.
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2-5 Setting the Z1 and Z2 Position

The cutting tool up position (Z2 point) and down position (Z1
point) are normally set with the software. 1f they cannot be set
with your current software then set them manually using the keys
on the switch panel.

1 Press the [EXIT] key to display the coordinate-view
screen.

Press the arrow keys and the tool up/down keys to move

2 the cutting tool close to the point where Z1 will be set.
When setting Z1, move the cutting tool to a position away
from the loaded workpiece.

3 Turn the dial to gradually move the cutting tool to the
height where the Z1 point is to be set.

4 Press the [Z] key.

Turn the dial to move the arrow to [Set Z1 Pos.HERE] for
5 Z1 or to [Set Z2 Pos.HERE] for Z2. Then press the

[ENTER] key.

The screen flashes once, then returns to the coordinate

view.

* The set valueis stored in memory even after you switch off
the power.

Tool up position

7 Tool
L
Z axis 70
originpoint = | L | :
) Workpiece g
71

Tool down position

*X 0Y 0
z 0 5000 RPM
Y
Z1

>2 Set Z1 Pos. HERE
3 Set 72 Pos. HERE

z2

>3 Set Z2 Pos. HERE
- <END>-
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2-6 Downloading Cutting Data

ACAUTION

Do not insert the fingers between Do not insert the fingers between
the XY table and base or between the T-slot table and arms or between

the head and Z cover. the head and Z cover.

Doing so may result in injury. The fingers may be pinched, resulting in
i injury.

Arm
Do not wear gloves, a necktie or Do not operate beyond capacity or
wide-sleeved clothing. subject the tool to undue force.
They may become The tool may break or fly off in a random

caught in the tool, direction. If cutting beyond capacity is

resulting in injury. mistakenly started, immediately turn off the
Z switch.
gbﬁﬂf
Wear dust goggles and mask during Use a commercially available brush
0 use. 0 to remove metal cuttings.
Cutting dust may scatter, causing bodily Attempting to use a 7
injury. vacuum cleaner to

take up metal //
cuttings may cause

fire in the vacuum

cleaner.
Perform dry cutting with no cutting
oil.
Such materials can
cause fire. J
|§ To keep cutting waste from being scattered, we recommend using a commercially available vacuum cleaner to take up
cutting waste during cutting. For information on attaching a vacuum cleaner, see "User's Manual 1 - Setup & Mainte-

nance."
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When performing cutting using three-dimensional data created with a commercial program (in DXF or STL format), output is from the
included MODELA player program. This document describes some examples of cutting using MODELA Player. Refer to "Part 3
Software Guide - 3-2 Cutting Using MODELA Player."

When performing output from the included Dr. Engrave program or acommercially available drawing program, use the included 2.5D
Driver (Windows only). For more information about the 2.5D Driver, see the help screens for the 2.5D Driver on the included CD-ROM
and "Part 3 Software Guide - 3-1 Windows Driver."

For information on how to use the included programs, take alook at "Part 3 Software Guide" and the help screens for each of the
programs.

When cutting starts, the screen at right appears. LOAD M n[ >>>>>>>] MAX

20000RPM

- You can change the spindle speed by turning the dial. Note that the changed spindle speed isin effect only during cutting.
- Pressing the [EXIT] key displays the coordinate view screen only while the key is held down. (Displaying the coordinates while
cutting isin progress may lengthen the cutting time.)

Stopping the Cutting Process

If you want to change the shape to cut and redo cutting from the beginning, or if the data was different from what you wanted to cut, then
follow the steps below to stop operation.

1 While operation isin progress, press the [PAUSE] key. PAUSE>CONTI NUE
Movement of the tool and table stops. Note that because STOP
thisis not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

2 Stop sending data from the computer

3 Stop execution of the program. PAUSE>STOP
X'Y CUT SPEED
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Changing the Feed Rate or Spindle Speed During Cutting

The feed rate and spindle rotating speed set by the software can be changed while cutting isin progress.

Thisis done by first pausing the MDX-650/500 during cutting, then changing the feed rate or spindle rotating speed. However, if the
computer subsequently sends a command to change the feed rate or spindle rotating speed, the setting will change as specified by the new
command. When set by software or set directly on the MDX-650/500, the setting made last takes precedence.

The following method is appropriate for making delicate halfway adjustments to conditions previously set using software, etc.

For more information about the spindle-motor speed and the feed rate, refer to "2-3 Setting the Cutting Conditions.”

1 While operation isin progress, press the [PAUSE] key. PAUSE>CONTI NUE
Movement of the tool and table stops. Note that because STOP
thisis not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

2 Turn the dial to move the arrow to the item you want, PAUSE>X/ Y CUT SPEED
then pressthe [ENTER] key. Z DOWN SPEED
3 Turn the dial to change the value, then pressthe [ENTER] PAUSE: X/ Y CUT SPEED
key. < 2 mis>
To change another item, press the [EXIT] key, then repeat
steps 2 and 3.
4 Press the [EXIT] key to return to the screen at right. PAUSE>CONTI NUE
STCP

Turn the dial to move the arrow to [CONTINUE], then
5 pressthe [ENTER] key.
The paused state is canceled and cutting resumes.
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2-7 Finishing

ACAUTION

Do not touch the tip of the blade
with your fingers.

Doing so may result in injury.

Please use a vacuum cleaner to
remove cutting dust.

Do not use any blower like airbrush.
Otherwise, dust spread in the air may harm
your health.

Do not touch the tool immediately
after cutting operating stops.
The tool may have become hot due to

friction heat and may cause burns if
touched.

Use a commercially available brush
to remove metal cuttings.

Attempting to use a 7
vacuum cleaner to ‘\\\\
take up metal // A8

cuttings may cause
fire in the vacuum
cleaner.

AN

After cutting has been finished, detach the tool, remove the material, and clean away chips.

1 Press the [EXIT] key to display the main menu.

2 Turn the dial to move the arrow to [MECHA MOVING],
then pressthe [ENTER] key.

3 Turn the dial to move the arrow to [Go LIMIT Pos], then
press the [ENTER] key.

4 Detach the tool.

>3 MECHA MOVI NG
4 ORI G N CHANGE

3> G LIMT Pos.
10 To Main MENU
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5

Turn the dial to move the arrow to [Go VIEW Posl], then
press the [ENTER] key.

Remove the material.

Use acommercialy available vacuum cleaner to take up
cutting waste.
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Part 3 Software Guide

This describes the general procedures for software you can use with MDX-650/500.

For detailed descriptions, take alook at the help screens for the respective software.

This section describes operation on the MDX-500. If you' re using the MDX-650, then wherever “MDX-500" appears in the text, read
“MDX-650" instead.

3-1 Driver for Windows

Driver for Windows 95/98/Me

This sends data to MDX-650/500 from a Windows-based program.

When sending data from Dr. Engrave or acommercially available drawing program, the driver sets engraving parameters such as the
tool’s operating speed, depth, and pitch.

When sending data from MODELA Player or 3D Engrave to MDX-650/500, the data is sent to the driver’s output port. At thistime, al
driver settings other than the port are ignored, and do not affect cutting.

This section explains how to make the settings for the engraving parameters.

Display the Driver Setting Screen

To make the settings for the driver, open Properties. You can use either of the two methods described below to open Properties.

Method 1

To save values you've changed with Properties, use this method to make the settings.

Click [Start]. Point to [Settings] and click [Printer].
1 The [Printers] folder appears. =] Brogran: :
23 [Documenis 2
:;} 5 efirgs F | Corhol Panel
é".l Fared E ] Firbeis
& Help B Takba
1 B
B Shut Diwr
r,ﬂGtut
2 Right-click on the [Roland MODELA MDX-500 (RML-
1)] icon, then click [Properties). Pilid
_p
KODELA Dipsrn
T |
HOHE0IR, Paaise Prindng
Puigs Firl Job:
Sl fug Dal
Create & horicad
[ it
Renans
Fropeiie:
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Method 2

If you opened Properties for the driver from a program, the values you set there are only temporary, and are not saved. To save the

Properties settings for the driver, use Method 1.

1 Start the program and open afile.

2 From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

3 Set the printer to [Roland MODELA MDX-500 (RML-
1)], then click [Properties].

Enter the Cutting Area
Enter the size of the workpiece installed on MDX-500.

1 Click the [Size€] tab.

2 Enter values for [Width] and [Length].

Fie Edi ‘iew Formaj Shag

M. Ciah J
Dipse (=N I
Bave CH+5
Sy iz,
Ll

_————————
Firl SaHug

Prir Salup 1x

Prinis
Base  ||Rols] MODELS WG SOAML ] = J
Siahn sy

Tips A ickasacd AWAICIAE L, ) DG SN AL -1
Wheie  DOM1
Cowwrnk

- Tt

S Il.l'.- Dk Sioe :l = Pt
Al
| El

P (WODELS MO-S00(RML-1] on COM1: Pioperties 7| ®|

e B 1LY

el - ETT
Leegth:  [3m0
Lind

& Hilmeten

O echies

Aedand WODELS MDX-SO0(RML-1] on COM1: Propeties T | x|

[Se | Tod | Oplioes |
Emaars dues

/it - (4000 \
L erugih - 3000
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Set the Engraving Parameters

You can assign different colors to the data and set the parameters for performing engraving of the corresponding data by color.

1 Click the [Tool] tab.

2 Click the tab for the color to set.
The numeral appearing next to the color is the tool
number that is now set.

3 Click the drop-down arrow for [Tool], then click the tool
number.
If you don’t wish to engrave lines of that color, click
[None].

4 For [Z Down Position], enter the cutting-in depth.
Cutting to the depth of [Z Down Position], with each
cutting pass made at the depth set with [Z Engraving
Pitch].

Aoland Boms\g MD-S00[RML-1] on COM1: Propefies 3] |

Sies I |

F#llngS==Ziing 7 |Seltng 3 | Selting 4 |
i 2] 3] 4w g]

Aoland MODELA MDX-S00(RML-1] on COM1: Properies 7] |
Sigs | Tod || Opiior |
Seling 1 | Satting 2 | Setting 3 | Setting 4 |

ilm 2] a]l” a|m s|W g]™ 7] |]

Hi|w 2w z|™g|ms|me|m 7| 8|

ok 1 =]

Aedand WODELS MDX-SO0(RML-1] on COM1: Properties 7| *|

Sigs | Tod || Do |

Seling 1 | Setting 2 | Setting 3 | Setting 4 |

W 2] 3] a|ms|m )T 2] -
Hi|m 2o = 4|ms|me|m7|

Tods [1 |

Aedand HWODELS MDM-SO0RML-1] on COM1: Propeties T | x|

Sigs | Tod | Opiiore |

S#lng 1 | Setting 2 | Setting 3 | Setting 4 |
18 2] 3] a|ms|mg] 2] -
[ | 1|- 2 N 3|W o4 |W 5NN 7 g
Toids |'| "I
E rui ar=w'a] Ciwuldnirn
A Spead & Spesd
|: Ill [rrive's] IE ﬂ et
 F Z Up Prsition
el T
0.2 2l [rviv] 2 Diowar \'osdion
Spirdis APM - [ =
I:'I":H_T a0 =] [ore]
||] =l — ,--ﬂl'\"'“SIF.-d'
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Ne=
|E If the tool-down position (Z1) is set at alocation lower Bad Par anet er
than the Z-axis cutting range, the screen at right appears
while cutting isin progress, and operation pauses.
When cutting material of uneven thickness using the depth regulator nose, set the tool-down position at a lower
height than the actual cutting depth (see "User's Manual 1 - Setup & Maintenance"). As aresult, the tool-down
position (Z1) is set at alocation lower than the Z-axis cutting range.
To clear the error message, switch off the power.
To avoid errors, place aflat board under the workpiece to serve as alifting base.
5 For [Fill Pitch], enter the diameter of the tool tip. Fetand WODELA MDX-S000RML-1] on COM1: Properties 7| |
To achieve an attractive finish, enter a value narrower ;
than the actual diameter. Sis | Tod | Oiphiors |
S#iing 1 | Seiting 2 | Seiting 3 | Setting 4 |
1]m 2] 3] a|ms|mg]T 2] -
UL AL T N A R L
Tools 1 ll
Eswgidrswng Cirlilains
WY Speed Z Gpesd
|: I|I [rriis] |E ﬂ et
= Z LUp Proition
. T
2| [vim] Z Doy Posiion
5 APM =
3w v [ . am = [rore]
[ T Ergrareing Pisch
1 |
Defot no = [
/\_/' ~

Driver for Windows NT 4.0/2000

This sends data to MDX-650/500 from a Windows-based program.

When sending data from Dr. Engrave or acommercially available drawing program, the driver sets engraving parameters such as the
tool’s operating speed, depth, and pitch.

When sending data from MODELA Player or 3D Engrave to MDX-650/500, the datais sent to the driver’s output port. At thistime, al
driver settings other than the port are ignored, and do not affect cutting.

This section explains how to make the settings for the engraving parameters.

To make the settings for a printer driver, you need full access permissions for printer setup.
Log on to Windows as a member of the “ Administrators’ or “Power Users’ group.

For more information about groups, refer to the documentation for Windows.

The description of the following procedures use screen shots from Windows 2000.

Display the Driver Setting Screen

To make the settings for the driver, open Properties. You can use either of the two methods described below to open Properties.
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Method 1

To save values you've changed with Properties, use this method to make the settings.

1

Click [Start]. Point to [Settings] and click [Printer].
The [Printers] folder appears.

If you're using Windows 2000, right-click the [Roland
MODELA MDX-500 (RML-1)] icon, then click [Printing
Preferences).

The [Printing Preferences] dialog box appears. Click
[Advanced].

If you're using Windows NT 4.0, right-click the [Roland
MODELA MDX-500 (RML-1)] icon, then click [Docu-
ment Defaults).

Method 2

If you opened Properties for the driver from a program, the values you set there are only temporary, and are not saved. To save the
Properties settings for the driver, use Method 1.

1
2

Start the program and open afile.

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

Set the printer to [Roland MODELA MDX-500 (RML-
1)], then click [Properties)].

If you're using Windows 2000, the [Property] dialog box
displays. Click [Advanced)].
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Enter the Cutting Area
Enter the size of the workpiece installed on MDX-650/500.

1 Click the [Work Size Settings] document option.
For Windows 2000, click [Properties]. For Windows NT

4.0, click [Work Size Settings].

The [Work Size Setting] dialog box appears.

2 Click [Add New Work Size], then for [Work Size], enter
values for [Width] and [Length].

3 Enter the [Work Size Name], then click [OK].
* For [Work Size Name], use only alphanumeric charac-

ters.
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Set the Engraving Parameters

Make the settings for the composition of the workpiece to engrave and the engraving depth.

Choosing the composition sets engraving parameters suited to this engraving. However, [Tool Down Position] and [Fill] - [Tool Width]
are determined with no relation to composition, and so they are set separately. For [Tool Down Position], enter the engraving depth. For
[Fill] - [Tool Width], enter the tool diameter.

The values for settings other than [Tool Down Position] and [Fill] - [Tool Width] are also suggested guidelines. If the results of actual
engraving are not as expected, modify the values accordingly.

Lines are distinguished by color, and parameters when engraving aline of the corresponding color are set.

1 Click any tool from 1 to 4 to display the lower level. " Roland MODELS MDE-SO{RNL 1) Advamced Hption 7] %)
Click [Material], then click the composition of the i _
engraving material (workpiece). = g Doousrmnt Optoni =
e b St Satirgi .

Engrir=m rity Spanclla O O
Sap Sparalla Biver Mat: [
Chariga Teod: Oy

B EEEEBBBHBBSE

2 Double-click [Color] to display the lower level. Posdained MODELA MOE-SOO(AML- 1) Advanced Detions 7]
Click the color to set, then click the tool number.

If you don’'t wish to engrave lines of that color, click = Tosld Al

[None]. [m il W] Sl
k= [t =]
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3 Double-click on the tool number to display the lower Posdand MODELA MIE-S00(RML-1 ] Advanced Dptions 7] x|
level.
Click [Z Down Position] and enter the cutting-in depth. = fu=d )

Cutting to the depth of [Z Down Position], with each
cutting pass made at the depth set with [Z Engraving
Pitch].

i) reriecnl W] Solt]

gon Al Oy

Toeod Wecithis 0 300 T ]
I-Spemed; |2 [reaninac]
o S

>

e ——till
Spindie Rerschition: 1
I Ergraving Fibce 1 200 pen
| M
e 3
i Py & r
| ra.s
P b

| M7 =

o Cocel |

v o
- T

If the tool-down position (Z1) is set at alocation lower Bad Par anet er
than the Z-axis cutting range, the screen at right appears
while cutting isin progress, and operation pauses.
When cutting material of uneven thickness using the depth regulator nose, set the tool-down position at a lower
height than the actual cutting depth (see "User's Manual 1 - Setup & Maintenance"). As aresult, the tool-down
position (Z1) is set at alocation lower than the Z-axis cutting range .

To clear the error message, switch off the power.

To avoid errors, place aflat board under the workpiece to serve as alifting base.

4 For [Fill], click [Tool Width], then enter the diameter of Pl FIODEL A MIKE-SOO0RML- 1) Advanced Dgtions i k|
thetoal tip.
- Toesd 1 j
[ T L = o
v EI = - o]
| ra1
Pobreeos

Fol T ey
sr-Speed. 12 [adaied]

T Caran Postion: 0,00 ey
£ Lip PasdEsc L) i
Spreds ReechEmn: {1

£ Erapaving Pbore ] 30 mim

+ M2
¢ | mea
# - | Mex#
£ | MeE
® - | MaB
£ | M =

For items other than [Tool Down Position] and [Fill] - [Tool Width], suitable values are set for engraving the composi-
tion you chosein step 1. However, these values are only suggestions. If the results of actual engraving are not as
expected, adjust the values accordingly.
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3-2 Application Software

i@ MODELA 3D DESIGN

Thislets you choose a basic shape such as a cylinder or sphere, and modify it to create a three-dimensional object.
You can intuitively create solid objects with smooth curves.

Choose the basic shape

1 aci[D1].

The [Primitives] dialog box appears.

2 g:tfelr( :22 ts)iazs;ctﬁw;pg It:I?t[g I;:I]osest to the finished form. Promitiems L
‘ . —_— T Prarmmeten 1
A ;# Bleius
4 D=ght

V.I-I.I.I-I.I.I-I.I.I-I.I.I-I.I.I-I.I.I-I.I.I-I.I.I-I.I.I-I.I.I-I.I.I-I.I.I-

Decide on the number of reference lines

The reference lines are control rods for arranging the shape of the object.
To determine the number of reference lines, click the controls shown below.

L : 4lines 131 - 7 lines 1% - 10 lines
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Manipulate Reference Lines to Make a Shape

To change the height of areference line, position the pointer over
the reference line and drag it up or down.

. ~

________

To change the size of the outer perimeter for areferenceline,
position the pointer over the reference line and drag it to the left or
right.

To change the shape of the outer perimeter, right-click on a Select sechion x|

reference line. .

The [Select section] dialog box appears. Sechion —

Make the settings to obtain the desired shape. S ':H‘ )
Carce
Chplicn

AR
| Elipae

Trackimd

m Hzight 7 a:

To change the centerpoint of the outer perimeter, click *d?* and
drag the reference line. ST -
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Check the shape

1 Click the | | .

The [Rendering] dialog box appears.

2 Drag the scroll box for the X, Y, or Z scroll bar.
The object rotates, letting you view it from various
perspectives. To color the object, click [Start].

Save the data

clickthe || .

The [Save Ag] dialog box appears.
Enter the name of the file and click [Save].

B ey x
bie L8 e (bwon Beskien e
izt sia) 2175 4 aietel@)-
||tz '!.J.I.I'_ R
=
..‘H
by =l
g g d |
Sl |
i) |
Oaskopaaa I_l
e |
T e |
| n-l |.-1r|
« A g
r 4 | i
£ | S
Sawve At e d 1|
Swmi  [iPrgen A & = = m

Flpars  |drsthed E]
Bawe 38 b0er [ addarign ez~ tha| E =7 |
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Description of Controls

[

N AT

e

This opens new file.
This opens an existing file.
This saves the file, overwriting the previous data.

This moves areference lines up or down.

When is selected, the location of the

centerpoint moves up or down.

This moves areference lines right and left.

When is selected, the location of the

centerpoint moves right and left.

When thisis selected, dragging areference line
changes the size of the outer perimeter.

When thisis selected, dragging areference line
moves the centerpoint of the outer perimeter.

7

L
% o

This saves the data as a DXF file.

This starts MODELA Player.

This undoes the very last operation.

'El This zooms the screen in or out.

This displays the coordinates of the reference
lines.

This changes the point of view.

This adds color and shadowing to the object's
surfaces.

L

. - This determines the number of
LZ gLs reference lines.

This displays help for 3D DESIGN.
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8% MODELA 3D TEXT

This adds thickness to text to create three-dimensional characters.
You can use the TrueType fonts registered in Windows as the font style for text.

Enter the Text
wpbramlag g =105

Click the [Edit] text box, then type in the text. e [ Fal e e e -
Make sure what you' ve typed in is correct, then click [Gol]. P [ 2 s [o ] e &= M]_

—
e ™
b
Bl N TG

B/ |0 AJAL | molemlal

| P | bl T

Determine the Font and Size of the Text

1 Click the [Font] drop-down arrow, then click on afont File Edt Font Lepth Wies

name. -
Fart ;| &rial

Arial

Courier Mew

b arlett

Syrnbal

Times Mew Foman
Wingdings

2 Click the [Scal€] drop-down arrow, then click on asize.
Scale ;|60 @
2IZI

Q_
|E - You cannot specify afont sizethat is not listed.
- If you want to know the size of the entire text string that you typed in, click [Show Information].

Save the data — 1
; Sty |4 Frogm o & ol m
Click the . - J EJ _J

The [Save As] dialog box appears.
Enter the name of the file and click [Save].

Flpwes  |Lradksd E@]
Swm a oy [ 347 e Files [~ 3] | ~—" |
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Description of Controls

=] bl & D

i

This opens new file.

This opens an existing file.

This saves the file, overwriting the previous data.

This changes how the object is displayed.

This starts MODELA Player.

This dants the text in the height direction.
L9 |£

This changes the height of the text.
| |dow ' g g

This determines the roughness of curved
Learse |Fina 9

portions of the text.

N

Thisinverts the background color.

& MODELA Player

For information on how to use MODELA Player, see “3-3 Cutting Using MODELA Player.”

Thislets you choose the color of the object from
among ten available colors.
This assigns the desired color to the object.

This displays dimensions around the object.

This savesthe dataas aDXF file.

A‘ This slants each individual character to the

left or right.

= [N R @ B B E [E

This puts aframe around the text.
This rotates each individual character 90 degrees
counterclockwise.

This makes the text italic.

This makes the text bold.
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Virtual MODELA

You can use atool path created with MODELA Player or 3D Engrave to verify the cutting process and results on-screen before you
perform actual cutting.

You can start this program directly with commands from MODELA Player or 3D Engrave. For more information, see"3-2 Application
Software 3D Engrave."

With Virtual MODELA, you can display the cutting process and results in awide variety of ways.

Animating the Screen During Simulation

—
Click the , thisbuttonison. When it is off, only the shape after simulation is displayed.

Switching the Screen Between Flat and Three-dimensional Views During
Simulation

i
e Clicking switches from aflat view to athree-dimensional view.
When this button is selected, the view is three-dimensional during and after simulation.

i
e Clicking switches from athree-dimensional view to aflat view.
When this button is selected, the display shows a view of the workpiece as seen from above during and after simulation.

Changing the Perspective at the Simulation Screen (Only During 3D View)

i
You can use the following buttons only when has been clicked to display a3D view.
e Clicking rotates the object counter-clockwise around the Z axis, in steps of 90 degrees.

e Clicking rotates the object clockwise around the Z axis, in steps of 90 degrees.

Checking the Shape After Simulation

You can use the following buttons only when has been clicked.

Rotating Zooming in or out
You can use the following buttons only when has been Click , then drag on the screen.
clicked.

Zoom in

Drag toward the top of the screen.

Moving the Location Zoom out

- Drag toward the bottom of the screen.
Click , then drag on the screen. «
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Description of Controls

This creates a new, uncut workpiece.

This opens an existing cutting-configuration file.

This saves the shape of the present workpiecein a
file.

This performs the cutting simulation over again,
using the presently imported tool path. Use this
when you want to check the movement of the tool

again.

This quits the simulation.

This starts cutting.
If cutting was previously interrupted, it resumes
cutting.

This displays a prediction of how much time
cutting will take. Thetime is a general estimate.
In addition to the time, you can also verify the tool
movement distance and movement range.

This displays the simulation screen as aflat (two-
dimensiona) view.

This displays the simulation screen as a solid
(three-dimensional) view.

These change the perspective when
j displaying a simulation three-dimension-

ally.

Thisisfor checking the shape after cutting
simulation.

This displays the movement of the tool with
animation.

This switches between adding and not adding
color to the surface of the workpiece.

To specify acolor, click [Options] - [Surface
Color].

Thisrestricts the 3D view range.

It also determines the printing area when perform-
ing 2D simulation.

Restricting the range makes 3D view faster than
when displaying the entire workpiece.

This pastes and image on the surface of the
workpiece.

By pasting an image of wood or metal, you can
make the workpiece look more realistic.

T o select theimage to paste, click [Options] -
[Texture Setup].

This rotates the object, changing the perspective.
Thisis available only during 3D view.

This zooms the view of an object in or out.
Thisis available only during 3D view.

This changes an object's displayed location on the
screen.
Thisis available only during 3D view.

This enlarges or reduces what is displayed to fill
the drawing size.

This selects how the object is
r & displayed when on the 3D screen

when not performing any opera-
tion.

This selects the image to paste on the surface of
the workpiece.

This changes the direction and brightness of
incident light, thereby changing the shading.
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Dr. Engrave

Thisis used to design plates and send the engraving data to MDX-650/500.
You can make large numbers of plates with the same design (such as nameplates and rating plates) with high efficiency.

Set the Engraving Area

The following explanation is for Windows 95/98/Me. If you're using Windows NT or Windows 2000, then refer to the explanation in "3-
1 Driver for Windows Driver for Windows NT 4.0/2000 Enter the Cutting Area."

1 From the [File] menu, click [Print Setup...]. Fin Ed Yiw Fomel Sha
The [Print Setup] dialog box appears. Hew. Caieh
Save Cus5
Sui fis.

L=

Selnct Souce...

Fint CsP
Frmit Prasymess
Fyint Sestug..

2 Make sure [Roland MODELA MDX-500 (RML-1)] is Prirk Satup Aix
specified as the printer, then click [Properties].

Frinds
The [Roland MODELA MDX-500 (RML-1)] dialog box v AT E |

appears.
Suhe ey

Tps Aiodred MODELS, W I0-S0AML]
Whes  [OMT.

3 Enter the size of the plate, then click [OK]. Nodand HODELS MDE-SO00RML-1] on COM1: Poperties 1'_3]

[52e || Tod | Optorn |
Ermglarmg Al

wiidth - fann \ 4
Lergify: 3000 :|

Next, click [OK] to close the [Printer Setup] dialog box.

4 The white portion of the screen is the engraving area. Lay
out shapes and text inside the area.
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Type in the Text Ty —
B[S You Fosw Shme Lewd bng

Click | & |, then click at the location where you want to typein Disa|a] | |[e][v sja) alojo]ofsf~|m

text.
Whilein this state, type in the text with the keyboard.

Draw a Shape Hip Uritiod - Du Engravs
Be [ Vow Fodel S Lol el

Click on the shape-drawing controls to draw the shapes. Diilnl-'—! | ||‘“T-"i'|~:l..| ﬁlll:‘l|'::||ll-"|5'-‘i|""'f|[!ﬂ

Change the Size and Location of a Shape or Text

Click | ® |, then click the shape or text.

Solid square ( Jlij) and triangle ( A ) pointers appear around the shape or text. To change the size, drag the pointers.

<Changing the Size>

l Drag to change the vertical size.

You can freely changethesizeofthe ___ g -
object by dragging. To retain the
object’s vertical/horizontal aspect
when you change its size, hold down
the [Shift] key while dragging.

Drag to change the horizontal size.
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<Rotating and Slanting>

Clicking again makes the pointers change to circles (@) and diamonds ( @ ).

Drag to rotate the shape. Drag the “ @” to slant the shape.
(O S—
S (O]
<Moving the Location> = A -
To change the location, drag between ] -
the pointers.
] ]
v
Save the Data Saren s

Fix|

click the [I]. S | AFien A & & = ml

The [Save Ag] dialog box appears.
O
bR L L I[IEIF.IM D emtrarmrd |* k] j

Enter the name of the file and click [Save].
| Pt |

Start Engraving Pt 2%
Prirds
Click the . Bass  |Fotored MOCE L MG SNARAHL -1 =] Fropate: |
The[Save Ag] dialog box appears. Sisr  Flmady
To start engraving with MDX-500, click [OK]. Tree  Flolsd MODELA M DG SOAMLA
Whee  COMA
Cipnngai I Prind i e
Prind Lyge Lol
5l H i o Coiimes | 3
. I : :
 Eaen Gl
(G e |
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Description of Controls

LJ

B [

2
L)
A

e

W

(B

=)

This opens new file.

This opens an existing file.

This saves the file, overwriting the previous data.

This sends engraving data to M DX-650/500.

This deletes the selected object and copiesit to the

clipboard.

This copies the selected object to the clipboard.

This copies the clipboard data to the screen.

This selects a shape or text.

Thisis used to reposition the vertices of a polygon,
changing its shape.

This zooms the screen in or out.

Thistypesin the text

This draws the shapes

Of (O

0] (=] |2

thy

=]

-

=

This makes an entry frame for text.

This changes the chosen text string to line
characters.

This performs flat-drag machining for the interior
of ashape or text.

These change the context of an object.

=)

These set the direction of the text string.

-_
Whi-
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ﬂ 3D Engrave

This adds thickness to aflat (two-dimensional) graphic to create arelief (raised engraving).
You can also add thickness to images such as illustrations.

3D Engrave is aprogram for creating reliefs (raised engravings) and engravings on curved surfaces.
This section describes the steps for cutting arelief.
For detailed descriptions of the creation steps and more information about creating data for engraving,

Select the Output Device

Choose the MDX-650 or the MDX-500 as the output device. For more information, take alook at "Part 1 Installing the Software 1-2
Setting Up the Windows Version of the Program Application Settings."

Decide on the Size of the Relief

1 From the [Relief] menu, click [Relief Size]. 2 Unititled - JDE rgavws
The [Relief Size] dialog box appears. Ele Eck View [mage Shape Feket it Hek
Biedef Size.
[rebate Fishel
Amnolhing
Enter the size of the relief and the resolution (the degree .
2 of deail of the relief), then click [OK]. Aeliet Size xl

Aesobabion |02 i
N [ e
3 The screen at right appears. The white area of the screen Sy — alB
is the where you design the relief. T N e e e ey
The screen displayed at thistime is called the "2D olsla| | |a|f= =] sl _
screen.” It's the screen for typing in text and L o =4 =1 | I 5 2 = e N O 0 Y F"ﬁ_

creating shapes.

(ST R [ - L -

=1 o mses—— |

53



Part 3 Software Guide

Creating Shapes and Entering Text - — 1
| o
- = R [ T

To create a shape, click one of the shape-drawing buttons and

To enter text, click the text-entry button, then click the location
where you want to insert text. While in this state, type in the text
with the keyboard.

To change the size of a shape or text, refer to "Dr. Engrave -
Changing the Size and Location of Shapes and Text."

Create a Raised Engraving (Relief)
Add thickness to shapes and text to create arelief.

1 Click the shape or text string you want for adding
thickness to select it.

2 ciamelZ]
The [Create Relief] dialog box appears.

The dialog box may differ depending on the type of object you selected. The following screen shows the dialog box that appears
when creating arelief of shapes or text.
Make the settings for the required items for creating the relief, then click [OK].

Croate Roliof |
Bettam 3,_‘,',':; i a1 1 Enter the height of the bottom of the relief.
_—r cancsl | | Enter the thickness of the relief.
| |—|| n| Pt I.r""-. (| These choose the configuration for pushing the
P EE object up (or down).
l IE "1'-‘|':"| -— These choose how to stack the relief.
B Smocsar |" EI

|
These choose whether to push down or stack using
the value entered for the relief height.

Thisisfor entering the angle of the base side when

has been selected.

Thisisfor entering the direction of the relief ridge.
You can enter avalue when a button other that

@ has been selected.

When thisis selected, the relief of the
chosen object is smoothed.
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The display changes automatically to the screen at right,
and a three-dimensional view of the shape of

therelief appears.

Thisiscalled the"3D screen,” and it displays the shape of
therelief and the tool path. You cannot edit shapes or text.

Creating a Tool Path

A tool path is the path followed by the tool's blade tip. Thetool path is generated from the cutting parameters that are presently set.
Before you create the tool path, make the settings for the cutting parameters. At the cutting parameters, make the settings for the compo-
sition of the workpiece, the type of tool, and the cutting process.

1

2

From the [Cut] menu, click [Cutting Parameters].

The [Cutting Parameters] dialog box appears.

Make the settings for the necessary itemsfor cutting, then
click [OK].

This chooses the composition of the cutting material.

This sets the depth for cutting.

R TTT S T — =100 =
Bl [ e ior s Bels [ pm

]| fnlml nf= sl
Y Y - e e N U

(ST R [ - L -

This chooses the cutting process.

Make the settings for the tool specifications.

Click the H"\ . When the tool path is created, it appears
in pink on the 3D screen.

Luting Fasamelsiz =|
[TPTSN ) pye——— A o |
e [0 e _ Carcal |
Prigess
I Dirat Cuting ™ Freching ljor Ergrarang]]
Towal
T o .
F SumsErdba | O £ =
 pisl Erd 10 mnm-luﬁ T

* EngwrgTeel | pmdeswge F12 g
Carvirg Corchions

”P-Ihl L5 . 5:;:"1:. T
mll o 2 [B —

i

R TTT S T — =100 =
Bl [ e ior s Bels [ pm

]| fnlml nf= sl
|m|o| | &l [s n]s] I’_Viil'_'ill__IJ_IJJ_g
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Checking the Cutting Results

If Virtual MODELA isinstalled and set up, then before you perform actual cutting you can check the shape that will be produced after

cutting on the screen.

1 From the [File] menu, click [Output Preview].
Virtual MODELA starts.

2 The cutting data from 3D Engrave isimported into
Virtual MODELA.
An animated display of tool movement appears, and the
shape after cutting is gradually produced.

Save the Data

Click the | =] .
The [Save As] dialog box appears.
Enter the name of thefile and click [Save].

Start Engraving

Click the .

When the screen at right appears, click [OK].
Cutting with MDX-500 starts.

Fla Sredsie ‘Swew [pbon He

2=t =M |5]

havn Al

Fi= Ecit Yew |mage Shape Febef [t Help
Hew T+
Open Cu+0
e LS
Sawedi
/W\/V\:
Dluspast Prassesy
Output Desice St
U Untised - Wislual HO

For more information on how
to operate Virtual MODELA,
see the help for Virtua
MODELA.

x|

Fawi —i I Ergrawm

A Bl ol = ml

IR
I Sy

Flepame:  |Lhsitled 3oe

Seves s bppec | H0E rgg avm Fie | e

'S

3DEnegrave

& Start cuttine.

Cancel |

X

56




Part 3 Software Guide

Description of Controls

i

2D

2>

This opens new file.

This opens an existing file.

This saves the file, overwriting the previous data.

This deletes the sel ected object and copiesit to the
clipboard.

This copies the selected object to the clipboard.

This copies the clipboard data to the screen.

This switchesto aflat (two-dimensional) shape-
editing screen.

This switches to a solid (three-dimensional)
display screen.

Display this screen when you want to check atool
path or the shape of arelief.

This adds thickness to shapes, text, images or
other flat objects to create arelief (raised engrav-
ing).

This creates atool path for engraving for the
selected shapes and text.

Thetool path for engraving appears on the 3D
screen asared line.

This creates the path that the tip of the blade traces
(the tool path).

The tool path for cutting appears on the 3D screen
asapink line.

This outputs the tool path to the MDX-650/500
and starts cutting.

Thistypesin the text

This draws the shapes
) O] (O
7| [£4
This selects a shape or text.

Thisis used to reposition the vertices of a polygon,
changing its shape.

.,.ﬁ? @ These are used to retouch imported

images.

This zooms the screen in or out.
The mouse operations for the 2D screen and the
3D screen are different.

This changes the display location of the object.
This moves the screen display to show areas
outside the window which are not visible.

This changes the perspective of the relief when
you drag the screen.
Thisis available only during 3D screen.

This command expands or reduces the size of the
object shown to fill the screen.

These select the pen width for
retouching an image.

[

Eﬂ These change the context of an object.

1=2=

These set the direction of the text string.

-..—
Whi=
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3-3 Cutting Using MODELA Player

This section provides a step-by-step explanation of the basic procedures for cutting a solid objects with MDX-650/500.
In this section, it is assumed that you have already completed making the three-dimensional data for the solid object. It is assumed that
the three-dimensional data you have prepared is three-dimensional datain DXF format.

- Open the three-dimensional data with MODELA Player and set the cutting parameters.
- Install the tool and mount the workpiece on MDX-650/500.

- Set the reference point for cutting.

- Perform surfacing and start cutting.

This explanation takes the sample data for the MODELA programs as an example of a solid object to be cut.

1. Create the Cutting Data

Prepare the data to be cut with MDX-650/500, and set the cutting parameters with MODELA Player.

Il Open the File

1 From the[FiIg] menu, click [Open...]. Unditled - MODELA Plager
The [Open] dialog box appears. Tl ES View [pien Hee

O Okl

2 Choose the desired file and click [Open]. lipsn ] |
ook iy 1 Sarmpke jgﬂ‘”_'ﬁj
] ey o
ETeE St
e [ (==)]

Flaral b [Puoectlain Fies | mde= i o] | =7 |
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[l Set the Cutting Paramete

rs

The cutting parameters are the parameters for cutting the solid object.

For MODELA Player, make these settings:

Cutting surface

: The surface of the solid object to be cut

Size : The size of the finished object

Depth : The depth of cutting

Workpiece : The composition of the material to be cut
Cutting process : The stage of cutting

Tool

*

conditions are selected.

: The diameter of the blade and the shape of the blade’s tip

When you use materials and tools for which choices are already available, then unless an incorrect selection is made, thereis
practicaly no chance of the tool breaking. Choose the loaded material and the installed tool.
When you use materials and tools for which choices are not available, the cutting parameters must be entered with great care. An

incorrect setting may result in overload that makes it possible for correct cutting to continue, and in worst cases may cause the tool to

break.

Make the settings for the cutting condi-
tions. Clicking [NEXT] advances the

setting screens in sequence from A to D.
Make the settingsin order from A to D.
(Clicking A, B, C, or D inthefigure
displays the corresponding setting screen,
this should not be used except whenit's
necessary to make settings independently.)

Click here to advance to
the next settings.

_omrrewm — MODELA Plaper  W0-500 (HEL-1]
(o el Ll el
This displays the path of
the tool during cutting.
B | I e curting by [STAAT] bution

When you set the parameters, the optimal movement speed, cutting-in amount, and so on when performing cutting under these

P e 1

¥

feCTLan I—— A
il B
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o i B
Crmft 1D

iy i B

A) Select the direction of the object

Select the direction to be used for cutting the object.
In the figure at right, cutting from above is selected.

=101 =|

Sakect tha direction
o e bt

*

| mack | PEAT I‘-TT.!.F:Tl

\
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B) Set the dimension

Make the setting for object's size. Drag the spin dial up or down,
or click on anumber and enter a value from the keyboard.
Clicking [Resize] makes it possible to specify aratio for the
dimensions.

C) Set the maximum cutting depth

Make the setting for the maximum cutting depth.

Drag the spin dia up or down, or click on anumber and enter a
value from the keyboard.

Clicking [Center] sets the depth at alocation proportional to the
height.

D) Tool diameter/Material/Finish

Tool
Set the type and diameter of the tool that isinstalled.

Material

Choose the composition of the loaded material.

Finish

When cutting a solid object on a modeling machine, an attractive
finish can be obtained by first performing rough (draft) cutting,
then performing fine cutting. Set to [Draft] for the first pass, and
to [Fine] for the second pass.

=101 x|
St e ol b ez by

B | HEAT |‘-TT.!.F:T|

/—\/\_/—\/\
—

=101 =

St tha maxmum
outtirg dagih

Crepth

i

Lasft

mm‘l

| Cammtar I

J BACE | MEXT I‘-?T.!.F:Tl

i

/\/\/\/\
I

Finish

Craft

Bk | REXT | =1ART |
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|E MODELA Player displays numerical valuesin 0.1-mm units. When you open afile containing setting valuesin units

smaller than 0.1 mm, the displayed values are rounded off to the nearest tenth of a millimeter. However, although
MODELA Player displays the valuesin 0.1-mm units, it uses the original setting values to perform cutting. Also, the
MDX-650/500 can display coordinate valuesin units of 0.01 mm. This means that the coordinate values displayed
during cutting may differ from the coordinates shown in MODELA Player.

Bl Checking the Cutting Results

If Virtual MODELA isinstalled and set up, then before you perform actual cutting with MDX-650/500
you can check the shape that will be produced after cutting.

1 From the [File] menu, click [Print Preview]. Fi: Edi Viesw [phon Hel
Virtual MODELA starts. Cipeein.. Chrl=Dl
Sava Coles
S fis
Clutgui
Cusdrad P
2 The cutting data from MODELA Player isimported into S Unitled - Vinusl MODELA <
Virtual MODELA.

X i Fle Siredste Yeesw Cpor Help
An animated display of tool movement appears, and the

shape after cutting is gradually produced. |2I|Et|'~ﬂ| | | | ”

* For more information on how to operate Virtual MODELA,
see the help for Virtual MODELA. [~
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B Save the file

1 From the [File] menu, click [SaveAs...]. Umtitled - MODELA Plager - MDX-15
The[Save As] dialog box appears. T Ed View Qpien Hel
[l pen [mi{ ]
G i
2 Choose where to save the file, type afilename, and click F—— X
[Save]. Thefile extensionis*.mdj”. S perpo— | El 1| I_El

Fin parea I::-Il-l I:J
v e popm |'«'l.'|:E.=="|-an—=‘--'-'r widl j Peri |

2. Install a Tool and Load Material

Refer to "User's Manual 1 - Setup & Maintenance" to install atool and load material on the MDX-650/500.

3. Set the Z-axis origin point

Set Z0 (the Z-axis origin point) on the surface of the loaded material.
For more information on how to set Z0, see "2-4 Setting the Origin Points (XY Origin Point and Z0) - Setting the Z0 Position.”
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4. Determine the Cutting Position

Align the mounted position of the workpiece with the cutting position of the object.

From the [Options] menu, click [Layout...].
1 The[Layout/Surfacing] dialog box appears.

The blue rectangle is the size of the object. Drag this area
2 to set the object’s cutting position.
The lower-left point of the orange rectangle is the X- and
Y-axis origin point for the MDX-650/500.

Double-clicking on one of the black circles displayed at

3 the four corners of the object lowers the tool at that
location. Thislets you visually confirm the cutting
location.

Continue by performing surfacing. See"5 Perform Surfacing” in
the next section.

To make only the setting for the cutting position without perform-
ing surfacing, click [OK].

o, sonew - HODELS Plape
Fie Ed Yiew Opon Help

[T

Bhshact 3
Crasioret Paamsie

Pty Drmction. .,
Hmchirss

lopmid | almeny

Blue rectangle

Black circles

_—l e

[TPE
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In addition to the method for determining the cutting position with MODELA Player, there is a method for setting the
X andY origin point with the MDX-650/500. For more information about how to set the XY origin point, see"2-4
Setting the Origin Points (XY Origin Point and Z0)."

The MDX-650/500's XY origin point (0, 0) corresponds to the lower-left point of the orange rectangle in the
MODELA Player [Layout/Surfacing] dialog box. This means that the maximum cutting range of the MDX-650/500
matches the orange portion only when the selection for [ORIGIN CHANGE] is[UNIT].

When [UNIT] is chosen for [ORIGIN CHANGE]

Maximum cutting range of the MDX-650/500
(orange rectangle)

7

\\\\\\\\\\\\\§

()

Machine origin point of the MDX-650/500
(0,0
When the XY origin point is set where you want

This portion is displayed on the MODELA
Player screen, but is outside the cutting range.

User origin point on the MDX-650/500 —‘
(0,0
Maximum cutting range of the MDX-650/500
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5. Perform Surfacing

ACAUTION

Do not insert the fingers between
® the XY table and base or between
the head and Z cover.
Doing so may result in injury.

N

Do not insert the fingers between

the T-slot table and arms or between

the head and Z cover.
The fingers may be pinched, resulting in

injury.

Arm

Do not wear gloves, a necktie or
wide-sleeved clothing.
They may become

caught in the tool, 1
resulting in injury.

T

Wear dust goggles and mask during

use.

Cutting dust may scatter, causing bodily

injury.

Do not operate beyond capacity or
® subject the tool to undue force.

The tool may break or fly off in a random

direction. If cutting beyond capacity is

mistakenly started, immediately turn off the

switch.

Perform dry cutting with no cutting

oil.
Such materials can
cause fire.

Qﬁ@
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________________________________________________________________________________________________________________________________________________________________________|

This cuts the surface of the loaded workpiece, creating alevel surface. Thisis called “surfacing.”
Surfacing is used to eliminate unevenness in the surface of the workpiece.
When performing surfacing, set the depth-direction reference point to the highest location on the workpiece.

At the MODELA Player [Options] menu, click [Layout...]. The [Layout/Surfacing] dialog box appears.
* Surfacing is not possible unless afileis open.

The slanted-line area is the surfacing range.

Lapoa | Serfaoag =
kriet P4 Tomha! 1D pgy Malew okt Sl (BT ]
ok | W ':
M i _
Enter the surfacing depth.
s This sets the depth from the depth reference
¥l point.
':: To change the surfacing range, deselect this.
= o g You can change the size by dragging the solid
e squares around the slanted-line area. You can
v, [TIEE also change the size by entering values in the
| T [Width] and [Length] text boxes.
A 1 L
oE | CemcE . i e ideey B —— Click [Start] to begin surfacing. When surfac-
L ing finishes, the plane that has been surfaced
is set to the depth-direction reference point.

When surfacing finishes, MODELA Player and the coordinate view on the MDX-650/500 automatically sets Z0 on the surface of the
workpiece after surfacing.

6. Perform Cutting

A three-dimensional object iscut in two stages: draft cutting and finishing.

First pass Draft cutting High-speed cutting that |leaves a margin for finishing
Second pass Finishing High-precision cutting of the margin on the workpiece surface left by draft cutting

When finishing ends, cutting is complete.
Depending on the composition of the workpiece, however, finishing may not actual produce an attractive finish.
In such cases, use afile or the like to work it by hand.

Click [START] to start cutting. “I_ E
mie

Tool path = =

BACK | START|
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While operation isin progress, press the [PAUSE] key.

[l Pausing or stopping operation

PAUSE>CONTI NUE

Part 3 Software Guide

Movement of the tool and table stops. Note that because thisis not STOP
an emergency stop, movement may continue for two or three
seconds before stopping.
The screen at right appears.
To continue with cutting
Turn the dial to move the arrow to [CONTINUE], then press the PAUSE>CONTI NUE
[ENTER] key. STOP
To end cutting
Stop sending data from MODELA Player.
Click [Start].
Point to [Settings...] and click [Printers]. =] Progemm: P
% Dipcumenis [
g},- 5 efirgs F | Corhol Panel
=I|'|: Fared E ] Firbeis
& Helo B Takba
3 Bun
BJ Shit Do
[Hstan
Double-click the [Roland MODELA MDX-500 (RML-1)] =
icon. 5
........ H:Lar‘u:l
. MODELA |
MDX-500MR..
At the [Printer] menu, choose [Purge Print Jobs] or
[Cancel] to stop sending data.
If you're using Windows 2000, choose [Cancel All
Documents].
Turn the dial to move the arrow to [STOP], then press the PAUSE>STOP
[ENTER] key. X/'Y CUT SPEED

NOTICE
immediately, and the MDX-650/500 may operate.

Depending on the model and the settings of the computer you' re using, data transmission may not stop

If this happens, then either wait until operation has definitely stopped, or press the [PAUSE] key, move the

arrow to [STOP], then pressthe [ENTER] key.
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4-1 Cutting Area

MDX-650

The maximum cutting area of the MDX-650 is 650 mm x 450 mm x 155 mm (25-9/16 in. x 17-11/16 in. x 6-1/16 in.). If you selected
RML-1 as the command set, then when converted to coordinate values (step size: /100 mm), (X, , z) = (50,000, 33,000, 10,500).
The actual cutting area of the MDX-650 differs according to the type of spindleinstalled.

When Use the High-torque Spindle (ZS-650T)

When a high-torque spindle (ZS-650T) isinstalled, the range that you can actually cut (in the height direction) is subject to the following
restrictions and is smaller than the maximum cutting range described earlier.

- Length of theinstalled tool
- Position of the XY table where the workpiece to cut is loaded
- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer

© ©
(@) ©
—

- - - - T-slot table upper
surface when

X-rail bottom
surface

155 mm(6-1/16 in.)
(Z-axis movable range)

105 mm
(4-1/8 in.)

EC —
Ex g £| using a spacer
NS Eo| (zA-508)

o

© o

| T-slot table
upper surface
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When Use the High-speed Spindle

When a high-speed spindle isinstalled, the range that you can actually cut (in the height direction) is subject to the following restrictions
and is smaller than the maximum cutting range.

- Length of the installed tool

- Position of the XY table where the workpiece to cut isloaded

- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer

- If using a depth regulator nose, the stroke of the spindle due to the nut (approx. 5 mm)

If using the depth regulator nose If not using the depth regulator nose
(nut loosened) (nut tightened)

~O -
= £2|E=s
".‘g EE ©o S| E ®
Ec < JoldN®
© 8|95 RN
SET P [
g s== - B €8 = Bt —— X-rail bottom
£3 E o 2| surface
E 2 0% Ea
€y 3 N E3
o % N 03
) cP A "y
BN ]
= = - - - - - - T-slot table upper
— = ~| surface when
E £ £3 E £| using a spacer
<9 N3 Q| (@ab1d)
-~ ™y
wS —Q
| | Y T-slot table
upper surface
I I
] ]
————— = @
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MDX-500

The maximum cutting area of the MDX-500 is 500 mm x 330 mm x 105 mm (19-5/8 in. x 12-15/16 in. x 4-1/8 in.). If you selected RML-
1 as the command set, then when converted to coordinate values (step size: 1/100 mm), (X, Y, z) = (50,000, 33,000, 10,500).
The actual cutting area of the MDX-500 differs according to the type of spindleinstalled.

When Use the High-torque Spindle (ZS-500T)

When a high-torque spindle (ZS-500T) isinstalled, the range that you can actually cut (in the height direction) is subject to the following
restrictions and is smaller than the maximum cutting range described earlier.

- Length of the installed tool
- Position of the XY table where the workpiece to cut isloaded
- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer

© ©
@) ©
—

— - - - - - - - T-slot table upper
surface when

X-rail bottom
surface

105 mm (4-1/8 in.)
(Z-axis movable range)

55 mm
(2-3/16in.)

ET —
Eo € £| using aspacer
NS Ew| (zA-508)

o

D

I I T-slot table
upper surface
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When Use the High-speed Spindle

When a high-speed spindle isinstalled, the range that you can actually cut (in the height direction) is subject to the following restrictions

and is smaller than the maximum cutting range.

- Length of the installed tool

- Position of the XY table where the workpiece to cut isloaded

- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer

- If using a depth regulator nose, the stroke of the spindle due to the nut (approx. 5 mm)

If not using the depth regulator nose
(nut tightened)

If using the depth regulator nose
(nut loosened)

~
~ 29 es
~© £ S| E
c2|Eg Lolas
£g|oY A1 R0
— ™
@ < I o
() — =
a9 g <]
13 - - £Eg - -
NI E°E =
g2 0 % £-=
Eg SR EQ
@ N )
7o) ~ &
33 rRY
T ]
N - _ _ _ _ _ _ )
—~ EZ —~
Ec 3 ES
) NS E®
< -d —Z o
0o )
)

X-rail bottom
surface

T-slot table upper
surface when
using a spacer
(ZA-508)

T-slot table
upper surface
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4-2 Coordinate System

The MDX-650/500 employs three separate coordinate systems (described below) according to the application or purpose of use.

Machine Coordinate

Under the machine coordinate system, the coordinates are
determined mechanically against the MDX-650/500. This system
forms the basis of the "work coordinates' which is explained later.
When [Go LIMIT Pos] is chosen for [MECHA MOVING] on the
display menu, the point to which the unit movesis the origin of
the machine-coordinate system (X, y, z) = (0, 0, 0). (The originis
fixed.)

The machine coordinate system basic unit isfixed as one step = 1/
100 mm (0.00039 in).

Work Coordinate

The origin of the machine coordinate system isfixed, but thereisa
coordinate system in which the origin can be moved relative to the
machine coordinate system. This systemis called the work
coordinate system.

In the work coordinate system, the home position isthe XY origin
and Z0 isthe Z axis origin. The origin of the work coordinates
can be set by setting the XY axis origin and Z0 (the Z axis origin).
The origin of the work coordinates is the standard point for cutting
against the attached workpiece.

The work coordinate system basic unit is fixed as one step = 1/100
mm (0.00039 in).

—

The origin of
the machine
coordinate

The origin of
the work
coordinate

z
A v
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4-3 Operating Each Function

Changing to Japanese Messages on the Liquid-crystal Display

You can choose either English or Japanese for the display language.

1 Switch on the power while holding down the [EXIT] key.
o
EXIT Q (@)
o s
o
" 7
2 Turn the dial to move the arrow to [JAPANESE], then >2 JAPANESE
pressthe [ENTER] key. - <END>-
3 Messages on the display now appear in Japanese. ENTER¥- 3 DRML-1
1794 ¥4 NC-CODE

* To return the display to English-language messages, carry out Step 1 again. When the language-selection menu appears
(similar to the one in Step 1, but in Japanese), move the arrow to “English” and press the [ENTER] key.

Performing Repeat Cutting

The data buffer is the place where data received from the computer is stored temporarily. (The datain the data buffer can be erased by
switching off the power or clearing the data.

Pressing the [COPY] key calls up the all cutting data stored in the MDX-650/500's data buffer and executes the replotting procedure.
When you perform replotting, clear the data from the data buffer before sending the cutting for replotting from the computer.

1 Pressthe [COPY] key. >1 COPY START
The screen at right appears. 2 CLEAR COPY BUFFER
2 Turn the dial to move the arrow to [CLEAR COPY >2 CLEAR COPY BUFFER
BUFFER], then pressthe [ENTER] key. - <END>-

Cutting datain the data buffer islost.
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3 Install the tool (blade) and load the material. Use the
software to send the cutting data.

4 After cutting has finished, remove the cut material and
load a new piece. Set the origin point if necessary.

5 Pressthe [COPY] key. >1 COPY START
Turn the dial to move the arrow to [COPY START], then 2 CLEAR COPY BUFFER

pressthe [ENTER] key.

Changing the Feed Rate or Spindle Speed During Cutting

The feed rate and spindle rotating speed set by the software can be changed while cutting isin progress.

Thisis done by first pausing the MDX-650/500 during cutting, then changing the feed rate or spindle rotating speed. However, if the
computer subsequently sends a command to change the feed rate or spindle rotating speed, the setting will change as specified by the new
command. When set by software or set directly on the MDX-650/500, the setting made last takes precedence.

The following method is appropriate for making delicate halfway adjustments to conditions previously set using software, etc.

For more information about the spindle-motor speed and the feed rate, refer to "2-3 Setting the Cutting Conditions."

1 While operation isin progress, press the [PAUSE] key. PAUSE>CONTI NUE
Movement of the tool and table stops. Note that because STOP
thisis not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.
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2 Turn the dial to move the arrow to the item you want, PAUSE>X/ Y CUT SPEED
then press the [ENTER] key. Z DOM SPEED
3 Turn the dial to change the value, then pressthe [ENTER] PAUSE: X/ Y CUT SPEED
key. < 2 mis>
To change another item, press the [EXIT] key, then repeat
steps 2 and 3.
4 Press the [EXIT] key to return to the screen at right. PAUSE>CONT! NUE
STOP

5 Turn the dial to move the arrow to [CONTINUE], then
pressthe [ENTER] key.
The paused state is canceled and cutting resumes.

* You can aso change the spindle speed while cutting isin progress by turning the dial. Note that the changed spindle speed isin effect
only during cutting.

Stopping the Cutting Process

If you want to change the shape to cut and redo cutting from the beginning, or if the data was different from what you wanted to cut, then
follow the steps below to stop operation.

1 While operation isin progress, press the [PAUSE] key. PAUSE>CONTI NUE
Movement of the tool and table stops. Note that because STOP
thisis not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

2 Stop sending data from the computer

3 Stop execution of the program. PAUSE>STOP
XI'Y CUT SPEED
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4-4 Descriptions of the Display Menus

1 SPEED OVER RIDE

1-1 X/Y CUT SPEED

Description

1-1 XY CUT SPEED Stored in Memory
< 2 mms> Yes

Factory Default
2

Setting Range
0.5, 1to 85

Steps
1

1-2 Z DOWN SPEED

1-2 Z DOWN SPEED Stored in Memory
< 2 mis> Yes

Factory Default
2

Setting Range
0.5, 1to 85

Steps
1

1-3 X/Y MOVE SPEED

1-3 X/ Y MOVE SPEED Stored in Memory

This sets the feed rate along the X and Y axes during cutting.
For details, see "2-3 Cutting Condition Setting".

Description
This sets the feed rate along the Z axis during cutting.
For details, see"2-3 Cutting Condition Setting".

Description

< 85 M s> Yes

Factory Default
85

Setting Range
0.5, 1to 85

Steps
1

This sets the speed of movement along the X and Y axes when the tool
israised.
For details, see "2-3 Cutting Condition Setting".
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1-4 Z UP SPEED

1-4 Z UP SPEED Stored in Memory  Description
< 85 mm s> Yes This sets the speed of movement along the Z axis when the tool is
raised.
Factory Default  For details, see"2-3 Cutting Condition Setting".
85

Setting Range
0.5,1to 85

Steps
1

2 SPINDLE RPM

2 SP| NDLE RPM Stored in Memory ~ Description
< 5000 RPM> Yes This specifies the spindle speed.
For details, see"2-3 Cutting Condition Setting".

Factory Default
3000

(High Torque)
5000
(High Speed)

Setting Range
3000 to 12000

(High Torque)

5000 to 20000
(High Speed)

Steps
100
3 MECHA MOVING
3 >1 Go ORIGA N Pos. Description
2 & Pos. This moves the tool to the specified location.

OR
20
3 9 G LIMT Pos.

10 To Main MENU
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4 ORIGIN CHANGE

4 ORIG N CHANGE Stored in Memory
<USER> Yes

Factory Default
USER

Selection Choices

USER, LIMIT,
CENTER

5 MOVING MODE
5-1 SPINDLE CONTROL

5-1 SPI NDLE CONTROL Stored in Memory
<O\> Yes

Factory Default
ON

Description

This specifies the location of the origin point for the X and Y axes.
For details, see "2-4 Setting the Origin Points (XY Origin Point and
Z0)".

Description

This chooses the method of control for the spindle motor.

ON When acommand to rotate the spindle is received, a
rotate signal isissued to the internal spindle. A signal is
also issued to the EXT2 connector at the same time.

Selection Choices  OFF Even when a command to rotate the spindle is received,
ON. OFE not rotate signal isissued to the internal spindle circuit.
EXTERNAL Similarly, no signal isissued to the EXT2 connector.
ONLY EXTERNALONLY Even when a command to rotate the spindle is received,
not rotate signal isissued to theinternal spindle circuit.
A signal isissued only to the EXT2 connector.
5-2 OVER AREA
5-2 OVER AREA Stored in Memory  Description

<CONTI NUE> Yes This selects the action when the tool returns from a coordinate outside

Factory Default
CONTINUE

Selection Choices

CONTINUE,
PAUSE

the cutting range to a coordinate inside the range. (Thetool cannot

actually be moved outside the cutting range, but the MDX-650/500's

internal processing handlesthis asif it had.)

CONTINUE  Operation is not paused upon return to the cutting
range. Cutting continues without interruption.

PAUSE Operation is paused when the tool returns to the
cutting range.
| "CONTI NUE" | | "PAUSE" |
Cutting Area Cutting Area
(500 mm x 330 mm) (500 mm x 330 mm)
(9-13/16 x 5-7/81n.) (9-13/16 x 5-7/8in.)
+Y/. +Y§/.
1 4 ’ 1 4 ’
_____ i 2 o : 2
O 0 SR L NG
- - +X ‘ — +X ‘
’Operatlon contmues‘ ’Operatlon is paused ‘
—-=x : Tool path
® O : Coodinate point
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5-3 SMOOTHING

5-3 SMOOTH NG Stored in Memory

Description

<ON> Yes

Factory Default
ON

Selection Choices

OFF, ON
5-4 ACCELERATION
5-4 ACCELERATI ON Stored in Memory
<0. 3G Yes

Factory Default
0.3

Selection Choices

Smoothing is afunction for cutting smooth arcs and circles. This
selects the type of smoothing. Smoothing can a so be switched off.
When shipped from the factory, thisis set to [ON.] If arcs cannot be
cut well using this setting, try changing it to [OFF.]

Description

This chooses the accel eration when moving the tool and table.
Normally the default value (0.3 G) can be left unchanged. When
cutting material that creates a high load, on rare occasions the
acceleration may make it impossible to perform cutting. In such cases,
the value should be changed.

0.05,0.1,0.3
6 COMMAND SET
6 COVWWAND SET Stored in Memory Description
<AUTO> Yes

Factory Default
AUTO

Selection Choices

This selects the RML-1 command mode. When set to [AUTO,]
[MODE-1] or [MODE-2] is determined automatically. If automatic
determination is not made correctly, find out what instruction system
the application software (or driver software) uses for data that is sent,
and change this setting to [MODE-1] or [MODE-2.] To determine
which mode your software is sending datain, refer to the documenta-

MODE-1, tion for the software.
MODE-2,
AUTO
7 CONNECTION
7 OONNECTI ON Stored in Memory Description
<AUTO> Yes

Factory Default
AUTO

Selection Choices

AUTO, SERIAL,
PARALLEL

This sets the type of interface used for connection to the computer.
When set to [AUTO], the port is determined automatically. The
communication parameters in effect when a serial connection is used
are according to the parameters of the panel settings.

If the interface cannot easily be determined when set to [AUTO], the
setting should be made manually.
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8 SERIAL PARAMETER

8-1 STOP BIT
8-1 STOP BIT
<1>
8-2 DATABIT
8-2 DATA BIT
<8>

8-3 PARITY BIT

8-3 PARITY BIT
<NONE>

8-4 BAUD RATE

8-4 BAUD RATE
<9600>

Stored in Memory
Yes

Factory Default
1

Selection Choices

1,2

Stored in Memory
Yes

Factory Default
8

Selection Choices

7,8

Stored in Memory

Description
This sets the number of stop bits for the communication parameters.

Description
This sets the data bit length for the communication parameters.

Description

Yes

Factory Default
NONE

Selection Choices

NONE, ODD,
EVEN

Stored in Memory
Yes

Factory Default
9600

Selection Choices

4800, 9600,
19200, 38400

This makes the setting for parity checking for the communication
parameters.

Description
This sets the bit rate (transmission speed) for the communication
parameters.
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8-5 HAND SHAKE

8-5 HAND SHAKE Stored in Memory

Description

Yes

<HARD- W RE>

Factory Default
HARD-WIRE

Selection Choices

HARD-WIRE,
XON/XOFF

9 COMPENSATE

Stored in Memory
Yes

9-1 X- COVPENSATE
<100. 00 %

Factory Default
100

9-2 Y- COVPENSATE
<100.00 %

Setting Range

9-3 Z- COMPENSATE 99.90 to 100.10

<100.00 %

Steps
0.01

10 OTHERS

10-1 SENSOR MODE

10-1 SENSOR MODE
Pl ease Cursor Mve

10-2 SPINDLE UNIT

10-2 SPINDLE UNIT Stored in Memory

This sets the type of hand shake for the communication parameters.

Description

This compensates for differences between the length specified by the
program and the actual cutting length. This can correct for error due to
temperature or humidity, as well as error due to individual differences
from one machine to another.

If you change the compensation value, then switch the power off and
back on. The changed compensation value is enabled after the power
has been reset.

Description

The Z0 sensor included with the unit is used to set the Z0 point on the
surface of the workpiece.

For details, see "2-4 Setting the Origin Points (XY Origin Point and
Z0). - Setting Z0 with the Z0 Position Sensor".

Description

<H GH TORQUE> Yes

Factory Default
HIGH TORQUE

Selection Choices
HIGH TORQUE,
HIGH SPEED

This sets the type of the installed spindle to MDX-650/500.
If ahigh-torque spindle isinstalled, choose [HIGH TORQUE]. If a
high-speed spindleisinstalled, choose [HIGH SPEED].
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10-3 BUZZER

Stored in Memory
Yes

10-3 BUZZER

<ON\>

Factory Default
ON

Selection Choices
ON, OFF

10-4 SENSOR HEIGHT

Stored in Memory
Yes

10-4 SENSOR HEI GHT
<15000 un»

Factory Default*
15000

Setting Range
0 to 30000

Steps
10

10-5 REVOLUTION TIME

10-5 REVOLUTION TI ME
0 Hour

11 SELF MODE

11-1 SURFACE CUT

11-1 SURFACE CUT
Are You Sure?[ ENTER]

Description
This switches on or switches off the confirmation sound heard when a
control key is pressed.

Description

The thickness of the Z0 sensor can vary dightly due to conditions of

temperature or humidity. This allows the sensor thicknessto be

adjusted to match actual thickness.

* The value that is set when shipped from the factory varies from one
MDX-650/500 unit to another .

Description

This displays the total rotation time of the spindle. The rotation time
cannot be returned to [0] (zero).

The displayed time should be used as an indicator for performing
periodic maintenance. (For more information about maintenance,
refer to the separate " Setup & Maintenance.")

Description

Thismenu item is for performing surfacing of the vacuum plate on the

optionally available ZV-500A vacuum table. For more information,

refer the User's Manual for the ZV-500A vacuum table.

* This menu item must not be used to perform surfacing for a
workpiece.
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12 Rotary Control

12 ROTARY CONTROL Description
This menu item is available when you are employ the optional rotary
axisunit. If the rotary axis unit is not installed, you cannot enter this

menu.
13 To Coordinate
*X 0 v 0 Description
VA 0 5000 RPM This displays the current tool location and spindle speed.

The units of measurement are in machine steps (1 step = 0.01 mm).
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4-5 What to Do If...

When the MDX-650/500 does not work...

Is operation paused?
Is the power for the MDX-650/500 switched on?

Is NC code chosen as the command set?

Cancel the paused state.
Make sure the MDX-650/500 is powered up.

Set the command set to RML-1. For more information about how to
make the setting, see "Introduction” in this manual.

When the spindle does not rotate ...

Is the SPINDLE COVER open?

Is [SPINDLE CONTROL] set to [OFF] or [EXTER-
NAL ONLY]?

Data cannot be sent

When using a serial connection, do the communica-
tion parameters for MDX-650/500 match the settings
for the computer?

Has the connection cable come loose?

Is the correct connection cable being used?

Is the correct output device set for the applica-
tion or driver software?

Close the SPINDLE COVER.

Refer to "Descriptions of the Display Menus' and change the setting
for "SPINDLE CONTROL" to "ON."

Refer to “2-2 Setting the Connection Parameters’ to make the correct
Settings.

Make sure the connection cable is plugged in securely with no
looseness at either end.

The type of connection cable varies according to the computer being
used. Also, some application software requires the use of a special
cable. Make sure the correct cable is being used.

Refer to the manual for the application or driver software to set the
output device correctly.

If you're using theincluded "2.5D DRIVER," refer to "Part 1 Install-
ing the Software."

The power does not come on...

Has the power cord come loose?

Make sure the power cord is plugged in securely with no looseness at
either end.
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The message "Unusable Parameter" appears and
operation stops

This appears when a specified parameter valueis out of range.

In particular, this appears when the tool-down position (Z1) is set at alower location than the Z-axis cutting range (105 mm).

When cutting material of uneven thickness using the depth regulator nose, set the tool-down position at alower height than the actual
cutting depth (see "User's Manual 1 - Setup & Maintenance"). As aresult, the tool-down position (Z1) is set at alocation lower than the
Z-axis cutting range (105 mm).

To clear the error message, switch off the power.

To avoid errors, place aflat board under the workpiece to serve as alifting base.

Changes to the feed rate and rotating speed of the
spindle motor made while cutting is in progress do not
take effect

Even when the MDX-650/500 is paused during cutting and the setting for the spindle rotating speed or feed rate is changed using the
display menus, the changed setting may not take effect.

Thisis due to the following causes.

- After the setting was changed, a command for spindle rotating speed or feed rate contained in data already sent was executed.

- After the setting was changed, a command changing the spindle rotating speed or feed rate was sent from the computer.

In such cases, change the setting on the computer.

The expected cutting precision is not obtained

The expected cutting precision may not be obtained when the cutting parameters and the end mill do not match.

Thisis due to the following causes.

- The amount of blade extension for the end mill istoo long.

- The shank diameter of the blade is too narrow with respect to the cutting parameters.

In such cases, change the cutting parameters (the end mill's amount of blade extension or shank diameter) to match the object being cut.
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4-6 Error Messages

An error message appears when the data being sent contains an error explained under "Description” in the table. However, only informa-
tion about the error appears on the display -- sending of data is not stopped, and the next operation is not prevented.

Pressing the [ENTER] key clears the error message from the display and pauses operation.

If an error occurs, correct cutting may become impossible. We recommend that you stop cutting and check the settings.

Error message

Description

of Paraneters

Conmand Not Appearsif an instruction that the MDX-650/500 cannot interpret is sent. This error is generated
Recogni zed if an instruction from the [MODE-2] set is sent when the unit has been set to recognize [MODE-
1,] or viceversa. Change the setting for the recognized instruction set, using the control panel,
and this error should no longer occur.
Wong Nunber Appearsif the number of parameters differs from the permissible number.

Bad Par anet er

Appearsif the value specified for a parameter is out of the permissible range.

Unknown
Character set

Appearsif an unusable character is specified.

Position Overflow

Appearsif coordinates being overflowed.

Buf fer Overflow

Appearsif the polygon buffer isfull.

/O Err: CQutput
Request COverlap

Appearsif an output instruction is sent from the computer during execution of a previous output
instruction. More precisely, there is a certain amount of delay between the moment an output
instruction is given and the instant actual output begins. This error message appears if the new
output request arrives during this delay time. (The delay time can be set using the [ESC].M
instruction.)

/O Err: Conmand
Not Recogni zed

Appearsif adevice control instruction that the MDX-650/500 cannot interpret is sent.

Paraneter range

[/OErr: Wong Appearsif aninvalid parameter has been specified for a device control instruction.
Par amet er
I/O Err: Qut of Appearsif the value for a device control instruction parameter exceeds the permissible limit.

I/O Err: Term nation
Error

Appearsif the number of parameters for adevice control instruction is more than that permis-
sible.
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Error message Description

|/ O Err: Fram ng/ Par- Appearsif aframing error, parity error, or overrun error occurs at the time of data reception.

ity Error (There is a problem with one of these settings: Baud Rate, Parity, Stop Bits, or Data Bits. The
protocol settings for the MDX-650/500 must be made correctly in order to match the settings
your computer is set to use.)

[/OErr: Buffer Appearsif the |/O buffer has overflowed. (Thereis a problem with the connecting cable, or the
' Overfl ow settings for Handshaking. Make sure you are using a cable appropriate for the computer being
used. Also, check that the setting for Handshaking is correct.)

/O Err: | ndet er ni na- Appearsif an undefined communication error occurs.
te Error
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4-7 Other Messages

Error message

Besides error messages related to commands or communication parameters, the following messages may also appear on the display.

Description

EMERGENCY STCP
EXT1 I'S NOT CONNECT

This appears when either the cable connecting the safety cover and the main unit or the key
connector is disconnected.

Switching off the power clears the message.

Make the connections correctly, then switch on the power.

EMERGENCY STCP
MOTOR LOCK  XYZS

The MDX-650/500 stops automatically if an excessive load is placed on the spindle or the X, Y,
or Z axis during cutting. The message shown &t |eft appears at thistime.

Switching off the power clears the message.

The overload may be due to excessive hardness of the material, an excessive amount of cutting-
in, afeed rate that is too fast, or operation being impeded by cuttings. Take action such as
changing the cutting parameters or cleaning the machine to eliminate the cause of the over load.

EMERGENCY STOP
SP/ SFTY COVER OPEN

This appears when the spindle cover or the safety cover is opened during operation.
SP: Spindle cover SFTY: Safety cover

Switching off the power clears the message.

Close the covers, then switch on the power.

CAUTI ON!
SP COVER OPEN

This appears when the spindle cover is opened during standby.
SP: Spindle cover
Closing the cover clears the message and returns the display to the coordinate view screen.

10-1 SENSOR MODE
Pl ease Cursor Move

This appears when the sensor mode is entered.

10>1 SENSOR MODE
ZOSENSCR NOTH NG

This error appears if the Z0 sensor is not connected when entering the sensor mode.
The display shows the message for several seconds, then returns to the previous screen.
Connection the Z0 sensor before entering the sense mode.

10>1 SENSOR MODE
SET Z ORIG N

This appears when Z0 is set in the sensor mode.

Comp. Effect After
Power On Again

This appears when the value for [COMPENSATE] is changed.
After setting the distance compensation value, switch the power off and on again to activate the
change.

When the amount of cutting data exceeds the capacity of the MDX-650/500's data buffer, this

'(I':Acg 1B-I gOIZD)XT A message appear when an attempt is made to perform recutting with this data. The data cannot all
fit in the MDX-650/500's data buffer, so repeat cutting cannot be performed.
CAN T COPY This message appears if repeat cutting is attempted when the data buffer is empty. Send cutting

BUFFER EMPTY

data before performing repeat cutting.
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Error message

Description

CAN T COPY
COVER OPEN

This appears when the [COPY] key is pressed to attempt to perform copying while the spindle
cover or the safety cover is open.

Closing the cover pauses operation. To perform copying, choose [CONTINUE]. To stop
copying, choose [STOP].
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4-8 List of RML-1 Instructions

* 1 -(22-1) to +(22-1)

model
Instruction Format Parameter Range [Default]
@ InputZl& Z2 @271,22 Z1 Positionon Z1 -10500to 0 [O]
z2 Position on Z2 0to +10500 [Q]
H Home H None
D Draw D x1,y1,x2,y2, ....,Xn, yn Xn, yn Absolute coordinate *1
M  Move M x1,y1, X2,y2, ....., Xn,yn Xn, yn Absolute coordinate *1
| Relative Draw I Ax1, Ayl, Ax2, Ay2, ..., Axn, Ayn Relative coordinate *1
Axn, Ayn
R Relative Move R AX1, Ayl, Ax2, Ay2, ..., Axn, Ayn Relative coordinate *1
Axn, Ayn
Velocity Z-axis V f f Feed rate for Z axis 0to 85 [mm/sec] [2 [mm/sec]]
Velocity X,Y-axis Ff f Feed ratefor X and Y axis 0to 85 [mm/sec] [2[mm/sec]]
XYZ-axis Zx1,yl,71, ..., xn,yn, zn XN, yn XY coordinate *1
Simultaneous Feed Zx1,y1,z1,..,xn,yn, zn zn Z coordinate *1
W  Dwell Wt t Dwell time 010 32767 [msec] [2[msec]]
AN Cdl mode2 A [mode2] [parameter].....
[parameter] []
mode2
Instruction Format Parameter Range [Default]
DF Default DF; None
IN Initialize IN; None
PA  Plot Absolute PAX1,y1(,X2,y2, ..., Xn,yn); XN, yn Absolute XY coordinate *1
PA;
PD Pen Down PD x1, y1 (X2, y2, ....., Xn, yn); xn, yn XY coordinate *1
PD;
PR Plot Relative PR Ax1, Ayl (,/AX2, Ay2, ....., Axn, Ayn Relative XY coordinate *1
Axn, Ayn);
PR;
PU PenUp PU x1, y1 (X2, y2, ....., Xn, yn); XN, yn XY coordinate *1
PU;
VS Velocity select VSs, s Feed ratefor X and Y axis 0to85 [mm/sec] [2 [mm/sec]]
VS,
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model, mode2 common instruction

Instruction Format Parameter Range [Default]
IDW Dwell IDW t [terminator] t Dwell time 0to 32767 [0]
IMC Motor Control IMC n [terminator] n Motor ON/OFF switching -32768 to 32767 [motor ON]
IMC [terminator]
INR Not Ready INR [terminator] None
IPZ SetZ71&72 IPZ 71 (,z2) [terminator] z1 Z1 coordinates -10500t0 0 [O]
72 Z2 coordinates 010 10500 [0Q]
IRC Revolution IRC n [terminator] n Spindle motor 0to15
revolution speed
IVZ Velocity Select VZ s [terminator] s Feed rate (Z axis) 01085 [mm/sec] [2 [mm/sec]]
Z-axis
1ZM Z-axis Move 1ZM z [terminator] z Z coordinate -10500to 0
1ZO Set Z0 1ZO z [terminator] z Z machine coordinate -10500to O
1ZZ XYZ-axis 177 x1,y1, 71, ....,, XN, yn XY coordinate *1
Simultaneous Feed zn Z coordinate *1
IZE ExtentionAxisMove |!ZE Xx1,Yyl, Zz1, Aal, XX2, ..... XY, Z,A Axis name (a phabet) AtoZoratoz
Xxn, Yyn, Zzn, Aan [terminator] Xn, ynzn Coordinate *1
zn
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4-9 Device Control Instructions

The Device Control instructions determine how communication between the MDX-650/500 and the computer will be handled using the
RS-232C interface; and al so are employed when relaying to the computer the status of the MDX-650/500. Some of them can be used to
format the output for RML-1 instructions.

A Device Control instruction is composed of three characters: ESC (1Bh), a".", and an uppercase letter. There are also two types of
device control instructions: one carries parameters and the other does not.

Parameters can be omitted. Semicolons, " ; " are used as separators between parameters. A semicolon without parameters means that

parameters have been omitted. Device Control instructions with parameters require aterminator to indicate the conclusion of the
instruction. A colon " : " is used as the terminator, and it must not be omitted.
No terminator is necessary for Device Control instructions without parameters.

Instruction | Format Parameter | Range ([]is default) | Explanation
Handshake Instructions
ESC .B [ESC].B None Outputs the current remaining buffer capacity to
Buffer Capacity the Output Remaining computer.
ESC .M [ESC].M<P1>;<P2>; P1: Delay time 0-32767 (msec) Sets handshake output specifications.
Set Handshake <P3>;<P4>;<P5>;<P6>: [0 (msec)]
Output P2: Output trigger character | [0 (Sets nothing)]
Specifications (1) P3: Echo terminator [0 (Sets nothing)]
P4: Output terminator [13 ([CR])] Note: When you specify some values to <P4> and
P5: Output terminator [O (Sets nothing)] <P5>, always set 0 to <P6>. When you specify
P6: Output initiator [0 (Sets nothing)] some value to <P6>, always set 0 to <P5>.
ESC .N [ESC].N<P1>;<P2>; P1: Intercharacter delay | 0-32767 (msec) Sets an intercharacter delay, and also an X off
Set Handshake [0 (msec)] character for performing the Xon/Xoff handshake.
Output <P3>; esese :<P1]1>: P2-P11 [All O (Sets nothing)]
Specifications (2) . Xoff character
(for Xon/Xoff)

Immediate response
character
(for ENQ/ACK)

ESC .H [ESC].H<P1>;<P2>; P1: The number of bytes | 0-15358 (byte) When receiving the ENQ character set by <P2>,
SetsENQ/ACK | <P3>; seseecee :<P12>: for data block [80 (byte)] compares the value set by <P1> and the remaining
Handshake Model P2: ENQ character [0 (Sets nothing)] buffer capacity, and returns the ACK character to

P3-P12
1 ACK character (only
when <P2> is set)

[All O (Sets nothing)]

the host computer when the remaining buffer
capacity is larger. The [ESC].H with no parameter

performs adummy handshake.
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Instruction Format Parameter Range ([]is default) | Explanation
ESC .| [ESC].I<P1>;<P2>; P1: Limit of theremaining | 0-15358 (byte) Used for performing the Xon/Xoff handshake and
Set Xon/Xoff <P3> ; eesesses :<P12>: | buffer capacity [80 (byte)] the ENQ/ACK handshake mode 2.
Handshake and (for Xon/Xoff) The[ESC].I instruction with no parameter performs
ENQ/ACK The number of data adummy handshake. In adummy handshake,
Handshake Mode2 block bytes (for ENQ/ always returns the ACK character to the host
ACK (mode2)) computer, regardless of the remaining buffer
P2: ENQ character [0 (Sets nothing)] capacity, when receiving the ENQ character.
(for ENQ/ACK (mode2))
0 (for Xon/Xoff)
P3-P12 [All O (Sets nothing)]
: Xon character (for XonfXoff)
ACK character
(for ENQ/ACK (mode2))
ESC.@ [ESC].@ P1;P2: P1: Ignored Controlsthe DTR signal (No. 20 pin of RS-232C).
ControlsDTR P2: DTR signal control | 0-255 [1] An even number parameter (e.g. 0) always sets the
DTR signal to High without performing the
hardware handshake. An odd number parameter
(e.g. 1) performs the hardware handshake and
controlsthe DTR signa according to the remaining
buffer capacity.
Status Instructions
ESC .0 [ESC].O None Outputs the status codes of MDX-650/500 shown
in
Outputs the Status the table below.
of Buffer, Pause Code| Meaning

0 Dataremaining in buffer.
8 Buffer empty.

16 | Dataremaining in buffer. MDX-650/500
being paused
(Pause On being displayed).

24 Buffer empty. MDX-650/500 being
paused (Pause On being displayed).
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Instruction Format Parameter Range ([]is default) | Explanation

ESC .E [ESC].E None Outputs an error code related to RS-232C interface
Output RS-232C (see the table below), and clears the error
Error Code simultaneously. At the same time, the error being

displayed is canceled.

Error | Possible cause and action

code

0 No /O errors

10 | Cause: after execution of an output
command, other output instructions are
sent before the output was not completed.
Action: let the computer to read the MDX-
500 output by the output instruction
and then send another output instruction.

11 | Cause: an error occursin adevice
control instruction.

Action: correct your program.

13 | Cause: parameters are overflowing.
Action: correct your program.

14 | Cause: the number of the parameters set
is more than specified or acolon *:’ was
not used to terminate.

Action: correct your program.

15 Cause: framing error, parity error or over-
run error at the time of data receipt .
Action: match the communication
protocols of both computer and MDX-
650/500 (baud rate, data bit length,
stop hit length).

16 | Cause: thel/O buffer overflows.

Action: This error does not occur when
hardware handshake is performed, but
may occur when software handshake is
performed. If this error occurs, check the
remaining buffer capacity of the MDX-
650/500 and send less data than the
remaining buffer capacity.

ESC .L [ESC].L None MDX-650/500 outputs the size of the I/0 buffer to
Output /O buffer the computer when receiving this instruction.
size It usually outputs 1024 (bytes).

Abort Instructions

ESC .J [ESC].J None Aborts both the currently executed device control
Abort Device instruction and output.

Control Instruction|

ESC K [ESC].K None Continues to execute the RML-1 instruction
Abort RML-1 in operation, aborts other incoming RML-1
Instruction instructions and clears the data buffer.

ESC .R [ESCI.R None Initializes all settings established by the device

Initialize Device

Control Instruction|

control instructions. Execution of [ESC].R brings
the same states as the following device control
instructions are executed.
[ESC].J, [ESC].M:, [ESC].N:, [ESC].H:,
[ESC].I: and [ESC].@:
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4-10 Display Menus Flowchart

Switch on the power while
POWER ON holding down the [EXIT] key
v 1 ENGLI SH
MDX- 650 >2 JAPANESE Select "ENGLISH"
Rol and DG Cor p. < [ENTER] - <END>-

v

Ht "ENTER' >RML-1 Select "RML-1"
Sel ect MODE NC- CCDE

* [ENTER]

MDE : RML-1
SPI NDLE: HI GH TORQUE

v

*X 0 Y 0
Z 0 5000 RPM
EXIT ENTER
[EXIT] * * [ ] SPEED XIY CUT
SETTING SPEED
>1 SPEED SETTI NG 1>1 X/ Y CUT SPEED 1-1 XY CUT SPEED
2 SPINDLE RPM > 2 Z DOW SPEED |— T % < 2mis>| ]
3 MECHA MOVI NG [EXIT] 3 X/ Y MOVE SPEED 0.5/1 to 85 mm/s
4 ORI G N CHANGE 4 Z UP SPEED 7 DOWN (In steps of 1 mnvs)
5 MOVI NG MODE 5 To Main MENU SPEED -
6 COMMAND SET - <END>- 1-2 Z DOMN SEEET% ]
7 CONNECTI ON > < s>
8 SERI AL PARAMETER \ 0.5/1 to 85 mm/s
18 &%E@SATE /Y MOVE (In steps of 1 mns)
11 SELF MODE SPEED 17375y MOVE SPEED
12 ROTARY CONTROL — < 85 mis>| ]
13 To Coordi nate
0.5/1 to 85 mm/s
- <RML/ MODEL| NG>- 7 UP (In steps of 1 mm/s)
Main Menu SPEED 17477 Up SPEED
— < 85 mis>| ]
0.5/1 to 85 mm/s
(In steps of 1 mm/s)
SPINDLE (EXIT]
RPM
2 SPINDLE RPM
— < 5000 RPMb
[HIGH TORQUE] mode selected: 3000 to 12000 RPM
MECHA [HIGH SPEED] mode selected  : 5000 to 20000 RPM  (In steps of 100 RPM)
MOVING
3 >1 Go ORIG N Pos.
> 2 Go Z0 Pos.
3 Go VI EW Pos.
4 Go Z1 Pos.
5 G Z2 Pos.
6 Go MAX Pos.
° 7 Go USER Origin
° 8 Go CENTER Pos.
° 9 G LIMT Pos.
: 10 To Main MENU
- <END>-
Next Page
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Previous Page

[ ]
[ ]
[ ]
[ ]
ORIGIN
CHANGE
4 ORIG@ N CHANGE
> <USER>
USER/LIMIT/CENTER
MOVING SPINDLE CONTROL
MODE
5>1 SPI NDLE CONTROL 5-1 SPI NDLE CONTROL
> 2 OVER AREA ] > <ON> | T
3 SMOOTHI NG ON/OFF/EXTERNAL ONLY
4 ACCELERATI ON OVER
5 To Main MENU AREA > O/ER AREA
- <END>- -
> <CONTINUE> | — |
\ CONTINUE/PAUSE
SMOOTHING
5-3 SMOOTHI NG
_> <O\l> J—
ON/OFF
ACCELERATION
5-4 ACCELERATI ON
> <0.3G |~ |
0.05G/0.1G/0.3G
COMMAND [EXIT]
SET
6 COWAND SET
B <AUTO>
MODE-1/MODE-2/AUTO
CONNECTION
7 CONNECTI ON
> <AUTO>
AUTO/SERIAL/PARALLEL
SERIAL PARAMETER STOP
BIT
8>1 STCP BIT 8-1 STOP BIT
> 2 DATABIT ] > <1> | 7]
3 PARITY BIT 1/2
4 BAUD RATE
o D ST gﬁ—TA 8-2 DATABIT
6 To Main MENU -
- <END>- > <8> | |
78
A PARITY
BIT 8-3 PARITY BIT
> <NONE> | —
NONE/ODD/EVEN
BAUD
RATE
8-4 BAUD RATE
° > <9600> | — |
. 4800/9600/19200/38400
i HAND
b SHAKE
8-5 HAND SHAKE
Next Page — <HARD- W RE> |~
HARD-WIRE/X ON/X OFF

[EXIT]
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Previous Page

[ ]
[ ]
[ ]
[ ]
COMPENSATE X-COMPEN-
SATE
9>1 X- COVPENSATE 9-1 X- COVPENSATE
> 2 Y- COVWPENSATE > <100.00 % | —
3 Z- COVPENSATE 99.90 to 100.10%
4 To Main MENU Y-COMPEN- (In steps of 0.01%)
SSEND SATE
9- 2 Y- COVPENSATE
\ L <100.00 % | — |
99.90 to 100.10%
Z-COMPEN- (In steps of 0.01%)
SATE
9- 3 Z- COVPENSATE
> <100.00 % | — |
99.90 to 100.10%
(In steps of 0.01%)
[EXIT]
OTHERS SENSOR
MODE
10>1 SENSCR MODE 10-1 SENSCR MODE
> 2 SPINDLE UNIT > Pl ease Cursor Move |~ ]
3 BUZZER
4 SENSOR HEI GHT
5 REVOLUTI ON TI ME SE'#DLE
6 To Main MENU 10-2 SPINDLE UNI' T
- <END>- > <H GH TORQUE> | —
\ HIGH TORQUE/HIGH SPEED
BUZZER
10-3 BUZZER
> <ON> | T
ON/OFF
SENSOR
HEIGHT
10-4 SENSOR HEI GHT
> <15000 ump | — |
0 to 30000 um
REVOLUTION (I steps of 10um)
TIME
10-5 REVOLUTI ON TI ME
> 0 Hour |~
[EXIT]
SELF SURFACE
MODE 151 SURFACE cuT CUT 111 SURFACE auT
> 2 To Main Menu P> Are You Sur e?[ ENTER] _|
ROTARY CONTORL [EXIT]
12 ROTARY CONTROL
_>
To Coordinate
*X 0Y 0

‘ P> 7 1500 5000 RPM
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Press the [PAUSE] key

\4

PAUSE>CONTI NUE
STOP

X'Y CUT SPEED
Z DOM SPEED
X'Y MOVE SPEED
Z UP SPEED
SPI NDLE RPM

- <END>-

AN

CONTINUE
— P Cutting continues
STOP
—P» Stopping the cutting process
XY CUT
SPEED -
> PAUSE: X/ Y CUT SPEED
< 2mis>| T ]
0.5/1 to 85 mm/s
Z DOWN (In stepsto 1 mm/s)
SPEED
> PAUSE: Z DOWN SPEED
< 2mis>| T |
0.5/1to 85 mm/s
XY MOVE (Instepsto 1 mmy/s)
SPEED .
> PAUSE: X/ Y MOVE SPEED
<85 mis>| |
0.5/1 to 85 mm/s
Z UP (In stepsto 1 mmy/s)
SPEED .
> PAUSE: Z UP SPEED
< 85 mmis>| T |
0.5/1to 85 mm/s
SPINDLE (In stepsto 1 mn/s)
RPM ;
> PAUSE: SPI NDLE RPM
< 5000 RPM> | T

[HIGH TORQUE] mode selected: 3000 to 12000 RPM
[HIGH SPEED] mode selected  : 5000 to 20000 RPM

(In steps of 100 RPM)

[EXIT]
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MDX-500

POWER ON

v

MDX- 500
Rol and DG Cor p.

\4

Ht "ENTER' >RML.-1
Sel ect MODE NC- CODE

* [ENTER]

MDE : RM.-1
SPINDLE: H GH TORQUE

v

*X
VA

0 Y 0

0 5000 RPM
[EXIT] *

* [ENTER]

>1 SPEED SETTI NG

SPI'NDLE RPM

MECHA MOVI NG

ORI G N CHANGE
MOVI NG MODE
COWAND SET
CONNECTI ON

SERI AL PARAMETER
COVPENSATE
OTHERS

SELF MCODE

To Coordinate

- <RML/ MODELI| NG>-

OO~ O WINE

10
11
12

Switch on the power while

holding down the [EXIT] key

1 ENG.I SH

>2 JAPANESE
- <END>-

[ENTER]

Select "RML-1"

SPEED
SETTING

>
[EXIT]

Main Menu

SPINDLE
RPM

_>

MECHA
MOVING

_>

Next Page

1>1 X/'Y CUT SPEED
2 Z DOMNN SPEED

3 XI'Y MOVE SPEED
4 7 UP SPEED
5 To Main MENU

- <END>-

AN

2 SPINDLE RPM
< 5000 RPW>

[HIGH TORQUE] mode selected:
[HIGH SPEED] mode selected

w
vV
[

ORI G N Pos.
Z0 Pos.

VI EW Pos.
Z1 Pos.
Z2 Pos.
MAX Pos.
USER Origin
CENTER Pos.
LIMT Pos.
Mai n MENU

- <END>-

SRRRRERE L

[EEN

Select "ENGLISH"
XIY CUT
SPEED
_ B 1-1 XY CUT SPEED
< 2mis>| ]
0.5/1to 85 mm/s
Z DOWN (In steps of 1 mmy/s)
SPEED
> 1-2 Z DONN SPEED
< 2mis> | |
0.5/1to 85 mm/s
XIY MOVE (In steps of 1 mmys)
SPEED
> 1-3 XY MOVE SPEED
<8 mms>|~ |
0.5/1to 85 mm/s
Z UP (In steps of 1 mm/s)
SPEED
> 1-4 Z UP SPEED
<85 mis> | |
0.5/1to 85 mm/s
(In steps of 1 mm/s)
[EXIT]
3000 to 12000 RPM
: 5000 to 20000 RPM  (In steps of 100 RPM)
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|

Previous Page

[ ]
[ ]
[ ]
[ ]
ORIGIN
CHANGE
4 ORIGA N CHANGE
L <USER>
USER/LIMIT/CENTER
MOVING SPINDLE CONTROL
MODE
5>1 SPI NDLE CONTROL 5-1 SPI NDLE CONTROL
B 2 OVER AREA -] > <ON> | T
3 SMOOTHI NG ON/OFF/EXTERNAL ONLY
4 ACCELERATI ON OVER
5 To Main MENU AREA > OVER AREA
- <END>- -
> <CONTI NUE> | — |
\ CONTINUE/PAUSE
SMOOTHING
5-3 SMOOTHI NG
_> <G\l> J—
ON/OFF
ACCELERATION
5-4 ACCELERATI ON
> <0.3G | T
0.05G/0.1G/0.3G
COMMAND EXT]
SET
6 COWAND SET
> <AUTO>
MODE-1/MODE-2AUTO
CONNECTION
7 CONNECTI ON
> <AUTO>
AUTO/SERIAL/PARALLEL
SERIAL PARAMETER STOP
BIT
8>1 STOP BIT 8-1 STOCP BIT
> 2 DATABIT ] > <1> | 7]
3 PARITY BIT 1/2
4 BAUD RATE
o D SR gﬁ-TA 8-2 DATABIT
6 To Main MENU -
- <END>- > <8>| ]
7/8
A N PARITY
BIT 8-3 PARITY BIT
> <NONE> | —
NONE/ODD/EVEN
BAUD
RATE
8-4 BAUD RATE
° > <9600> | — |
. 4800/9600/19200/38400
L HAND
i SHAKE
8-5 HAND SHAKE
Next Page — <HARD- W RE> | —]
HARD-WIRE/XON/XOFF

[EXIT]
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Previous Page

[ )
[ )
[ )
[ )
COMPENSATE X-COMPEN-
SATE
9>1 X- COVPENSATE 9-1 X- COVPENSATE
— | 2 Y-COPENSATE | T <100.00 % | ]
3 Z- COVPENSATE 99.90 0 100.10%
4 To Main MENU Y-COMPEN- (In steps of 0.01%)
- <END>- SATE
9-2 Y- COVPENSATE
w_ — > <100.00 % |~
99.90 to 100.10%
Z-COMPEN- (In steps of 0.01%)
SATE
9-3 Z- COVPENSATE
— <100.00 % | —
99.90 to 100.10%
(In steps of 0.01%)
[EXIT]
OTHERS SENSOR
MODE
10>1 SENSOR MODE 10-1 SENSCR MODE
— 2 SPINDLE UNI'T —T % | Please Cursor Mve |
3 BUZZER
4 SENSOR HEI GHT
5 REVOLUTI ON TI ME SmDLE
6 To Main MENU g | 10-2 SPINDLE UNIT
- <END>- <H GH TORQUE> | — |
\ HIGH TORQUE/HIGH SPEED
BUZZER
10- 3 BUZZER
— <ON> |
ON/OFF
SENSOR
HEIGHT
10-4 SENSOR HEI GHT
— <15000 ume | ]
0 to 30000 um
REVOLUTION (In steps of 10 um)
TIME
10-5 REVOLUTI ON TI ME
— 0 Hour |~
[EXIT]
SELF SURFACE
MODE 751 SURFACE Ut CUT 111 SURFACE auT
— | 2 To Main Menu [P | Are You Sure?[ ENTER] —|
[EXIT]
To Coordinate
*X 0 v 0

P> 7 1500 5000 RPM
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Press the [PAUSE] key

\4

PAUSE>CONTI NUE
STOP

X'Y CUT SPEED
Z DOM SPEED
X'Y MOVE SPEED
Z UP SPEED
SPI NDLE RPM

- <END>-

AN

CONTINUE
— P Cutting continues
STOP
—P» Stopping the cutting process
XY CUT
SPEED -
> PAUSE: X/ Y CUT SPEED
< 2mis>| T ]
0.5/1 to 85 mm/s
Z DOWN (In stepsto 1 mm/s)
SPEED
> PAUSE: Z DOWN SPEED
< 2mis>| T |
0.5/1to 85 mm/s
XY MOVE (Instepsto 1 mmy/s)
SPEED .
> PAUSE: X/ Y MOVE SPEED
<85 mis>| |
0.5/1 to 85 mm/s
Z UP (In stepsto 1 mmy/s)
SPEED .
> PAUSE: Z UP SPEED
< 85 mmis>| T |
0.5/1to 85 mm/s
SPINDLE (In stepsto 1 mn/s)
RPM ;
> PAUSE: SPI NDLE RPM
< 5000 RPM> | T

[HIGH TORQUE] mode selected: 3000 to 12000 RPM
[HIGH SPEED] mode selected  : 5000 to 20000 RPM

(In steps of 100 RPM)

[EXIT]
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